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2. What is VocAlign Ultra”?

e Introduction to VocAlign Ultra
e What's New?

e What does VocAlign Ultra do?
e Main Applications

e How does it work?

Introduction to VocAlign Ultra

VocAlign Ultra is a powerful but easy-to-use plugin that can automatically match the

timing and pitch of one audio signal to the timing and pitch of another audio signal.
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What's New?

The main improvement over previous versions of VocAlign Project and VocAlign Pro is the

addition of pitch matching and display to the toolbox, drawing on the proven and extensive

technology behind Revoice Pro 4, but we've also added:

New in VocAlign Ultra 1.1: A simpler workflow using SmartAlign to

automatically align Guide and Dub audio regions.

A library of presets to help you quickly get the right settings for a variety of jobs
and signal types.

A basic and advanced set of controls to adjust the amount and modes of
timing and pitch matching.

3 view windows showing waveforms, pitch traces or signal energy displays.

A movable timing Offset Display showing points of alignment in the Guide and

Dub waveforms.
Improved tools for correcting small issues: Protected Ranges and Sync Points.
A pitch transpose control.

A formant control for adjusting the pitch range of resonances.

What does VocAlign Ultra do?

In a nutshell, VocAlign Ultra enables dialogue editors and music producers to quickly and

easily align one vocal or instrumental performance with another in the time or pitch

domains, or both.

As any dubbing editor or music producer knows, lip-syncing and double tracking vocals

and instruments can be a painstaking, laborious process, highly dependent on the ability of
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the performer to repeat themselves accurately, and often involving many takes to get a

workable final result.

With VocAlign Ultra brought into the process, you can let the artist concentrate on creating
a great performance, without worrying about the detailed timing mismatches relative to the
guide track or pitching imperfections. The plugin automatically and transparently applies
the required amount of variable time-stretching and pitch-shifting to match the Dub to the

Guide, saving studio and artist time, and delivering natural-sounding results.

Perhaps most importantly, VocAlign Ultra allows your artist to produce their best
performance, free from the stressful rigidity and repetition traditionally associated with re-
recording or doubling tracks.

Main Applications

VocAlign Ultra can be used for all manner of corrective and creative purposes, including:
In post production:
e Syncing replacement dialogue for film and video.

e Matching the pitch profile and intonation of overdubbed dialogue to the original

recording.
e Tightening up lip-syncing with foreign language dubs.

e Changing the vocal timbre or even gender of an actor’s performance.

In music production:
e Double-tracking vocal and instrumental parts.

e Replacing the vocals in a music video shoot with a production track, to achieve

perfect lip-sync.
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How does it work?

VocAlign Ultra works by applying varying amounts of time-stretching and compression to
one signal — the ‘Dub’ — to align its energy peaks and troughs over time with those of a
‘Guide’ signal. It also can modify the pitch of the Dub (whether time-aligned or not) to

match the pitch of the Guide.

VocAlign Ultra Simplified

GUIDE .
SIGNAL MODIFIED
TARGET

(DUB) SIGNAL
ANALYZE SELECTED FEATURES

DETERMINE AND APPLY TIME-ALIGNED + B . -
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Audio signal names are coloured to be similar to those in the VocAlign Ultra Interface.

TARGET
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VocAlign Ultra does its processing in three main steps:
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1. VocAlign Ultra analyzes the Guide and Dub audio signals using identical

spectrum analyzers to produce time-varying energy patterns and pitch maps for

both signals. Also the time-varying pitch of both signals is measured.

2. Advanced pattern recognition techniques are used to compare the two energy
patterns and pitch maps, and determine the best way to ‘warp’ the Dub's timing
and pitch (if selected for matching) to align the Dub timing and pitch to the
Guide signals. A the time-warping path is created to specifies the best time-
distortion of the Dub for matching to the Guide according to the “Matching”

tightness setting.

3. The time-warping path feeds into an audio editing processor that time-stretches
and -compresses the Dub audio signal and, if selected, modify its pitch to the

desired tightness, to create the Aligned version.

It is this time and pitch-aligned version of the Dub that is the processed Output, which
is returned to the host DAW.

Previous Next
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3. General Information
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3.1. Contact Information

CONTACT DETAILS

Synchro Arts Limited

Epsom, Surrey, UK

Information info@synchroarts.com
Sales: sales@synchroarts.com
Technical Support: support@synchroarts.com
Telephone: +44 800 107 7220

Web: http://www.SynchroArts.com
Office howrs 9:00 to 17:00 GMT

Monday to Friday

Trademarks and notices

VocAlign is a registered trademark of Synchro Arts Limited.
Pro Tools is a registered trademark of Avid Technology, Inc.

All other trademarks are the property of their respective holders.
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3.2. About this User Guide

e How to Use This User Guide

e User Guide Structure

e Other ways to get help

How to Use This User Guide

This User Guide is set out to help you learn:

e How to Install and Uninstall the plug-in package

e Whatis in the installed VocAlign Ultra package?

e Which of the Plug-in Versions you can use with your DAW(s)

e How to use each Plug-in Version with your DAW (via Quick Start Guides)
e How to use VocAlign Ultra in depth

e Some Tips and Tricks for getting the best results

User Guide Structure

1. The User Guide Contents (on the left) provides links to the major Topics mainly

described above.

2. After explaining installation and authorisation, you will need to find out which

Plug-in Version appears in your DAW.

12
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3. Then you can use the Quick Start Guides to follow the basic steps to use your

chosen version with your DAW.

4. If your DAW is not listed, but supports VST3 or AU, then you can use one of the

DAW guides most similar to yours.

Other ways to get help

Latest Information, Audio Examples, Tips and Tricks

Click this Link at the top of the page

LATEST INFO- VOCALIGN ULTRA AND YOUR DAW

to get the latest information plus a growing collection of sample audio, demos
and tips and tricks for using VocAlign Ultra with different DAWs on the Synchro

Arts website.

Tutorial videos

On-line videos are being created and updated to help users quickly understand

the general and detailed operation of VocAlign Ultra.

Some helpful videos have direct links from this manual.

13
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Also, click here to go to the Synchro Arts Videos filtered for VocAlign Ultra to

see numerous explanations of how to use the application in a variety of creative
situations.

Previous Next
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3.3. Control Devices

Input Control Devices

A range of positioning and control devices can be used with VocAlign Ultra including

a mouse with one button, two-button mouse, Magic Mouse, track pads, track balls etc.

In this Guide, we have used the familiar terms "LEFT CLICK" and "RIGHT CLICK" which

might not be appropriate for the user's control device. What is meant is this:

e LEFT CLICK - device operation that selects an item

¢ RIGHT CLICK - device operation that brings up a menu of selectable items in a

"short-cut" or "context-dependent" pop-up window.
For detailed information on your device controls or setting it up, look in any of the following:
¢ MAC and Windows System Preferences - Mouse

¢ Mac and Windows Help for "mouse"

e Your control/pointing device in the device's User Guide

Previous Next
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4. Installation and Authorization

e Installation and License Overview
e How to Authorise your VocAlign Ultra plug-in

e How to Redeem your iLok Activation Code

Installation and License Overview

Installation

If you have not already done so, download the macOS or Windows VocAlign
Ultra plug-in installer from www.synchroarts.com/downloads or your DAW's

specific pages.

When you open the installer on your Mac or PC, it will install the following VocAlign Ultra

plug-ins:

o AAX (Audio Suite) for Pro Tools

e« VST3 and VST3 (ARA) for Cubase, Nuendo, Studio One, Ableton Live and other
DAWSs supporting VST3 plug-ins

and, on macOS only

AU (Audio Units) and AU (ARA) for Logic Pro X and other DAWSs supporting AU plug-ins

License Overview

VocAlign Ultra uses the iLok system described on www.iLok.com to authorise your
plug-in.
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You can obtain Trial Licenses from www.SynchroArts.com or purchase Full

(non-expiring) or rental licenses from Synchro Arts or its resellers.

e Rentals and Trial licenses will run the software fully-functional for the number of

days stated in the information provided with the licence.

e The license includes 2 activations that will go into your iLok account so you can

activate two locations.

e All licenses will authorise both macOS and Windows versions.

The locations which can be activated are:

e Lok USB Keys Version 2 or 3 (see details below)
e Machines (i.e. computers)
e Lok Cloud

e Lok Network server (for larger organisations). Contact ilok.com for details.

iLok USB Keys

You can only use the iLok 2 or iLok 3 USB Keys (pictured below).

Note: These are often referred to as simply "iLoks" in many user guides.

17
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iLok USB Keys can hold licenses for a number of protected software

products.

They can be easily moved from one computer to another to authorise
iLok-licensed products.

You can have licenses from Synchro Arts and other software vendors on
the same iLok.

iLoks can be purchased from iLok.com or from most pro-audio product

vendors.

How to Authorise your VocAlign Ultra plug-in

IMPORTANT: Before you can run VocAlign Ultra, you must do all of the following (if

you haven't already done so).

Skip steps 1-2 if you already have an iLok account.

1.

2.

Create a free account on www.iLok.com .

Go to www.iLok.com, download and install the latest iLok License

Manager on your computer.

If you are using an iLok USB key, plug it into a USB port on your

computer.

Run the iLok License Manager and sign in to your iLok account.

If you have a License in your iLok.com account, the License Manger

will display it and let you drag its name to one of the three destinations

mentioned above:

o An iLok USB key that is plugged into your computer.

o The iLok Cloud

18
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o Your computer (machine)

6. If you don't have a License but instead have received an iLok Activation

Code in the form:
X=X =X =X = XXX =X = XXX X = XXX X=X X
(where X's are numbers).

you can redeem this code in the iLok License Manager to obtain your licence. This

is described next.

I If you already have installed a VocAlign Ultra licence in iLok cloud, or on your
computer or on an iLok USB Key that is plugged into your computer, then you can
run VocAlign Ultra and skip the next section on license authorization.

How to Redeem your iLok Activation Code

1. Open the 'Redeem Activation Code' window in the iLok License Manager.

@ iLokLicense Manager File View : Window Help

Activate (5’ réﬁ.rﬁt l
Deactivate 136D

Take Ownership

Redeem Activation Code ¥R

Transfer License... 36T

Refresh Subscriptions

2. Enter your Activation Code as instructed.

19
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Enter Activation Code

You can copy your entire activation code and paste it into any box.

3. If the code is recognized, you will receive a VocAlign Ultra License in the

iLok License Manager.

4. Once you have a License in your iLok.com account, the License Manger will
display it as VocAlign Ultra 1 with 2 Activations available and images of the 3

possible destinations.

Q

Publisher Name  Subtype Expiration Date Deposit Date Tyvpe

Revoice Pro 4 Synchro Arts Ltd. Product 08/10/2017 10:58 Not for Resale 0 of 1 activations used
ET Revoice Pro 4 Synchro Arts Ltd. Product 08/10/2017 10:58 Not for Resale 0 of 1 activations used

Export CSV Hide Detalls

_ | VocAlign Ulira 1
S5 synchro Arts Ltd.

' Activate

License Status Active
g Type License
Subtype Product gob Transter
Expiration Date
Activate By Date 2> Hise
Deposit Date  10/01/2021 19:40 @ wwwsynet

Activations 0 of 2 activations used
& support@s)
Activation Locations
|

INFORMATION
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5. You can now drag the license (hame) to one of the three destinations

mentioned above:

Bl Clicking a license destination below will take you to the instructions
for authorising that location.

e AniLok USB key that is plugged into your computer with name showing.
e Your Computer name (machine)

e The iLok Cloud

Authorising using iLok USB Key

In the iLok License Manager, drag the VocAlign Ultra License name to the

name of your iLok USB Key as shown in white letters below.

cence Manaoer

Valid Locations Product Name
i U= VocAlign Ultra 1

. VocAlign Ultr:
" Synchro Arts Ltd.

21
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The License Manager will give instructions and tell you when you

have successfully put the license in your iLok USB Key.

For further information on iLok, go to www.iLok.com.
Removing the iLok USB Key

If you remove the iLok and then try to run VocAlign Ultra without the iLok
inserted into your computer, you will receive a warning message. Follow the

instructions in the warning to reauthorize the software.

& Do not remove the iLok from your computer while you are using
VocAlign Ultra.
If the iLok is removed VocAlign Ultra will allow you to save your
session and then close.

Authorising using your Computer (Machine)

In the iLok License Manager Drag the VocAlign Ultra License name to

the name of your Computer.

See image below showing an example of moving one Activation to a MacBook

Pro computer.

22
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Publisher Name Subtype Expiration Date Deposit Date Type Activations
10/01/2021 19:40 License 2 of 2 activations used

Export CSV Hide Detalls

"'s Cloud

& Close Your Cloud Session

Cloud Session Status Opsnon®. . MacBook Pro”
Cloud Session Open since 10/01/2021 23:57 Switch to Managed Mode
ILok Cloud Mode Automatic
Number of Licenses 1

For further information on iLok, go to www.iLok.com.

Authorising using iLok Cloud

If you have already redeemed your Activation Code and your VocAlign Ultra
license is available in iLok License Manager, you can launch VocAlign Ultra and
Open a Cloud Session by following these steps:

o Start the iLok License Manager and log into your iLok account.

o Then select the menu File -> Open Cloud Session

23
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@ iLokLicense Manager ;58 View Licenses Window Help

Open[<loud Session {+3C
Close Cloud Session

Connect to PACE Central
Export License Data...

Find License

If you have a cloud session on another computer you will be warned
that session will be closed.

The Cloud session should now be opened with the following message.

iLok License Manager

Cloud Session Open Successful

A cloud session has been opened from this machine. All elfgible cloud
enabled licenses have been activated to the cloud. A

If you would like to activate these licenses to a different Iocanm and
don't have more activations, you will need to close your cloud session to
move the licenses back into your account.

Operation In progress... This cloud session will remain open until you close it using the Close
Cloud Session menu option or open a cloud session from a different
machine.

When you OK the screen shown above, you should see this something like this

and you can now use VocAlign Ultra.

24
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Valid Locations Product Name Publisher Name Subtype Expiration Date Deposit Date Type Activations
=] VocAlign Ultra1  Synchro Arts Ltd. Product 10/01/2021 19:40 License 2 of 2 activations used

Export CSV Hide Detalls

"'s Cloud

& Close Your Cloud Session

Cloud Session Status Openon . - MacBook Pro™
Cloud Sesslon Open since 10/01/2021 23:57 Switch to Managed Mode
ILok Cloud Mode Automatic
Number of Licenses 1

A If you are using a iLok Cloud session and your Internet connection is lost
or interrupted, VocAlign Ultra will close.

Previous Next
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4.1. Uninstalling

How to Un-Install the plug-ins

On macOS

On Windows OS

1. Go to Add or remove programs
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Settings

e Add a printer or scanner >
R, Add, edit or remove other users >
¢ Link your phone >
Search work and web

L Add - see work and web results >
Apps (3)

Documents - This PC (1+)

Folders (5+)

2 Add| or remove programs I

2. Search for VocAlign Ultra.

27
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| VocAlign Ultra 207 MB
s 11/01/2021

0.1.0.19

3. Select Uninstall and follow the instructions.

Previous Next
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4.2. Important File Locations

Locations of VocAlign Ultra Files

File locations in macOS

Preferences files are in
~ILibrary/Preferences/com.synchroarts.VocAlignUltraAAX.plist
~/Library/Preferences/com.synchroarts.VocAlignUIltraAU.plist
~/Library/Preferences/com.synchroarts.VocAlignUItraVST3.plist

Default process settings are in

~/Library/Application
Support/SynchroArts/VocALignUltra/UserPresets/VocAlignUltra/DefaultSettings

Recently used preset list are in
~/Library/Application Support/SynchroArts/VocALignUltra/UserPresets/VocAlignUltra/Recent.list
User presets are stored in

~/Library/Application Support/SynchroArts/VocALignUltra/UserPresets/VocAlignUltra

File locations in Windows

Preferences are stored in the registry.
User presets are stored in
%AppData%\SynchroArts\VocALignUltra\Presets
Default process settings are in
%AppData%\SynchroArts\VocALignUltra\Presets\VocAlignUltra\DefaultSettings
Recently used preset list is in

%AppData%\SynchroArts\VocALignUltra\Presets\VocAlignUltra\Recent.list
29
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Previous Next
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5. VocAlign Ultra Plug-in Versions and
DAWSs

e VocAlign Ultra Versions
e VST/AU ARA Plug-in Operation: Features

e VST/AU - Realtime Capture: Features

VocAlign Ultra Versions

The installers for macOS and Windows OS will install all the plug-in types below. Only some will

work with your DAW.
You can see from the chart below which plug-in versions will work with your DAW.
If there are two (or more) types that will show up in your DAW, you must decide which one you

want to use before you load it.

This User Guide will tell you more about the differences.

Click this link for a complete up-to-date list of Compatible DAWS.
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* Recommended when supported by DAW.
** Please note ARA mode will not work when using Logic Pro 10.6 on Apple Silicon (Unless you run

Logic in Intel mode/Rosetta)

What are the differences between ARA Capture and VST3 or AU (Real

Time Capture)?

The next two sections explain the features, benefits and issues of the two types of

plug-in operation.

VST/AU ARA Plug-in Operation: Features

e Fast capture of audio

o For short segments it will seem almost instantaneous.
32
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e Ease of setup — in most cases DAWs make this straightforward

o (Studio One, Cubase/Nuendo and Cakewalk in particular)
e Some Daws add ARA plugins to:
o entire tracks (Logic , Reaper)

o audio segments / events (Cubase, Studio One, Cakewalk etc).

o both- Reaper can add ARA plugins to either entire tracks or individual

segments.
e Transportable projects — the DAW takes care of loading and saving all ARA data.
¢ Integrated/dockable display in some Daws. (Studio One and Cubase/Nuendo)
¢ Instant replay of processed signals.
¢ ARA supports limited Undo/Redo (Render/Restore) if one is careful
e Control from the plug-in of the position of the DAW’s playback cursor

e Captured Guides and Dubs are labelled with names from DAW.

WARNING: The time range of the processed signal using ARA is limited to
the exact time range of the Dub.

For example, if the plug-in's processing generates an output that is longer
than the original Dub,

the DAW will not replay the audio that comes after the original Dub
segment. However, in nearly all cases this limitation does not cause any
problems.

A WARNING: VocAlign Ultra ARA plug-in must be the first plug-in in a chain of
processing and there can be only one ARA plugin in a chain.
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This precludes having VocAlign Ultra and any other ARA plugin (e.g., Melodyne) on
the same segment of audio.

VST/AU - Realtime Capture: Features

e The capture of audio is more flexible than ARA's as the ‘captured audio’ can
span any number of audio segments and intervening silences in the DAW.

e The length of the captured Guide will always be the same as the captured Dub.
e Instant replay of processed signals.

e The length and timing of the processed signal is not constrained by the timings

of the Dub audio as it is in ARA See (6) in the ARA section above.
e DAW must support VST3 /AU sidechains

e Configuring the plug-in can be complicated. It depends on the DAW's plug-in
operations:

o The Guide track needs to be routed to the plug-in's sidechain.
o Configuring the routing of the sidechain is simple in some DAWSs (e.g.,

Logic, Studio One)

o and complex in other DAWs (e.g., Reaper).

e The capture of audio happens in real time. A 30 second piece of audio takes 30
seconds to capture both Guide and Dub.

e Itis usually much slower to process a project using the real time plug-in than it
is to process the same project using the ARA plugin.

e Not able to integrate (dock) the plug-in's display.

¢ No Render and Restore is available (see note 2 below)

e Cannot reposition the DAW’s playback cursor from the plug-in.

e Transportable “Realtime” projects (sessions) for VST3 DAWS but in AU DAWS

(Logic Pro) the “Realtime” project is tied to your Apple computer.
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e It possible to chain the real time plug-in after any other plugin, though in our

case there is rarely any good reason for doing this.
Further detail

e Once you have added the Guides and Dubs to Ultra, the real time plugin and the

Ara plugin work in much the same way.

e Apart from the ‘Capture’ buttons, all Ultra's presets and knobs will work in

exactly the same way in both versions of the plugin.

e There is not much ability to control the undoing or redoing of anything in the
real time plug-in from the DAW itself. For example, in Studio One using ARA you
can Render and then Restore an alignment (i.e. Bounce in place/Undo bounce in
Place/Redo Bounce.. /ad infinitum), whereas in the real time plug-in the

‘Restore/Render’ option is not available.

e You can continue to adjust the ouput audio from Ultra but not from the DAW.

You can bypass the VocAlign Ultra Playback.
e Audioisin a separate file to be read and output during playback.
e ARA DAWSs knows about the audio.

e You can you have both VST3 Realtime and VST3 ARA in same Studio One

project as long as they are on different tracks.

PreviousNext
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6. Using VocAlign Ultra
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6.1. Operational Overview

e VocAlign Ultra - Operation Overview
e Start with a Preset

e Important! Your DAW is a variable

VocAlign Ultra - Operation Overview

In this section, we describe what the interface(s) looks like and the general flow of

operations you will use.

There are 3 different interfaces you might see, depending on what DAW you use and

which plug-in type you are using. This will be explained in more detail later.

[Updated video 'Learn VocAlign Ultra in 7 minutes' for VocAlign 1.1 with SmartAlign

workflow forthcoming]

Start with a Preset

A task-orientated library of presets covers a broad array of common
usage scenarios, and often, you won’t need to do anything more than Select a preset, to
get the job done. However, you can always adjust the Match Timing and Match Pitch

"tightness" controls to get a tighter or looser sounding result.

The screen below shows a VocAlign Ultra’s screen with Basic controls showing on the

right side.
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Editor

VOCAIign ULTRA *Vocal - Double - High Pitch Dub - Slightly Loose Timing & Pitch v Basic

0:00:38.000 0:00:40.000 0:00:42.000
:
Tiny Heart Tuned Lead Vocal(3)-24b T B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

TIGHT
DUB Lead vox High Choru! it 33ms

B SmartAlign
-2) Capture &

B FORMANT SHIFT

OQUTPUT

Ready o » p..
W &=
Tiny Heart Tuned Lead Vocal(3)-24b

‘” Lead vox High Chorus(3)
Delete

VST3 (ARA)

Switching to Advanced mode, however, reveals several further controls governing the
nuances of the algorithms at work in the audio editing processor, as well as a linear

pitch transposition control for creative pitch-shifting.

Editor L e B X

Voc/.\lign ULTRA  *Vocal - Double - High Pitch Dub - Slightly Loose Timing & Pitch Advanced o ?

0:00:38.000 0:00:40.000 2.000
Tiny Heart Tuned Lead Vocal(3)-24b B MATCH TIMING @ MATCH PITCH

Max Difference Max Difference Pitch Target

Sync Points @ @

TIGHT LOOSE TIGHT DUB
DUB Lead vox High Chorus(3) 33 ms 20%
Algorithm Target Mode

—
apture Mode 1 Nearest Octave v

Normal Flexibility

Transpose
Protected Areas B SmartAlign

OUTPUT

Ready ot » ”""

Max Shift No Limit v
HIGHER

B High Resolution
W = B FORMANT SHIFT PITCH RANGES

Tiny Heart Tuned Lead Vocal(3)-24b BHEE Normal

\” Lead vox High Chorus(3) Dub  High Pitched Vocal
Delete

VST3 (ARA)
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In addition, the Formant Shift control facilitates dramatic tonal shaping

and vocal ‘gender’ changes.

Important! Your DAW s a variable

VocAlign Ultra requires the Guide and Dub audio to be captured (imported), and

the Processed audio to be exported back to the host DAW.

However, the process of getting audio into and out of the plugin varies widely between
different DAWs since they have one or more standards for doing this, which includes

AAX (AudioSuite), VST3, AU, and ARA 2 for VST3 and AU. See Versions and DAWs

Because of this, we provide Quick Start sections for the most popular DAWs which
describe one or two methods of getting your audio into and out of VocAlign Ultra for
each plug-in standard used by these main DAWs. We will also explain when these

steps (or very similar) wllll sometime apply to other DAWSs.
In the next sections of this Guide, we describe the operations that are universally

applicable to all DAWSs that can support VocAlign Ultra.

Previous Next
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6.2. SmartAlign Overview and What is New in 1.1

SmartAlign

SmartAlign is a new feature first included in VocAlign Ultra 1.1 that intelligently
resolves the issue of aligning audio in a Dub that doesn't start or end at the same
points on the timeline as the Guide. It uses the position of the Dub to find the
matching audio in the Guide, rather than the other way round, and then aligns the

Dub to the Guide as usual.

If you're used to the previous versions of VocAlign, you'll be all too familiar with the
process of cutting out sections of long Guides in order to match them up to the start

and end points of the Dub. With SmartAlign, you no longer need to do that.

Be aware, however, that SmartAlign expects each section of Dub-matching audio
in Guide to start no more than 0.25s before the start of the matching audio in the Dub.
In all the following examples, we'll show you to align the Dub to the Guide first with

and then without SmartAlign.

Although SmartAlign might appear to be a function you would never want to turn off,
because it's so new, we wanted to retain the option to let you use the original
algorithm in case of unexpected results. And if your Guide and Dub audio regions start
and stop at roughly the same points in your DAW anyway, SmartAlign may sometimes

not be required.

However, we recommend you always keep SmartAlign ON unless there is a problem

doing that.
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New in VocAlign Ultra 1.1

e In Logic Pro when using the ARA version, it is no longer necessary to press start
and stop before each Capture. Instead clicking any Capture button in VocAlign
will automatically initiate a start and stop. You will hear a small burst of

playback before VocAlign then captures the selected audio.

e Updated presets library making use of SmartAlign.

Previous Next
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6.3. Presets and Working in Basic Mode

e  Working with presets

e Loading a preset

e Inspecting the Results of Processing
e Modifying the preset

e Manually Changing Control Settings

e Saving and managing presets

Working with presets

VocAlign Ultra’s preset library is organised in a task-based hierarchy that makes it easy
to find the right setup for the job at hand, be it tightening up a vocal harmony,
matching a voiceover artist’s overdub to the original actor’s dialogue, or bringing

cohesion to a horn section.

A VocAlign Ultra preset is really just one particular configuration of all its
parameters, made to help you complete a specific music or post-production task. The

factory presets should be useful as starting points for most cases.

Of course, the specifics of your source material may well necessitate the tweaking of
those parameters to some extent, so presets should be viewed as highly

targeted starting points rather than ‘set and forget’ instant fixes. Having edited

a preset to tailor it to your needs, if you want to use it again, be sure to save it as a

User Preset (giving it a helpful name) so you can try it on similar material in the future.

Loading a preset
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To load a preset, click the preset menu at the top of the interface

VOCAIig N ULTRA Vocal - Double - Slightly Loose Timing & Pitch

and browse through the menu structure to the preset with the name that most closely

describes the source material and results you're aiming for.

The menu hierarchy is not rigid, but an example of presets for Vocal Doubles is shown

below:

Recent P ming & Pitch v

101 Dialogue > 1 331 41 49|1 57]1 651
iny Hea|  Instrument >
Rap >
Vocal > Double Creative
Default Tight Timing Harmony Dub with Gaps - SmartAlign OFF
High Pitch Dub
Low Pitch Dub
Save AsPree jh Chorus(3) Legato Voices - Tighter Timing
Manage Users Presets Slightly Loose Timing & 8ve Pitch
Slightly Loose Timing & Pitch
Slightly Loose Timing & Pitch Mode 2

User

The heirarchy largely follows the levels described below:

e Tier 1 - signal type: Choose Vocal (sung), Instrument (melodic or percussive
instruments) or Dialogue (spoken word).

o Tier 2 - Relationship or Task: Here's where we specify the relationship
between the Guide and the Dub, from a range of options including vocal and
instrumental Doubles and Harmonies, Rap vocals, and

Dialogue Replacement and Inflection Transfer.
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Many tasks are further divided into subcategories, such

as describing different pitch ranges of source material - Low Pitch

Dub and High Pitch Dub, for example. These are used to deliver better
quality editing for signals or used to set controls for situations like “Dub with
Gaps - SmartAlign OFF".

Tier 3 — tightness: Each task is presented at several degrees of

‘tightness’, governing how strictly the timing and pitch of the Dub are aligned with
the Guide. For example, the basic Vocal Harmony task comes in Slightly

Loose and Tight Timing options.

Exceptions to this are the Creative Vocal presets, which are described in terms

of upward or downward pitch and formant shift, or, simply, Make monotone. These
unusually detailed ones are mainly included to indicate some possible options

the user might find useful to know about.

The Recent folder will show the last 5 presets you have used which

have their original settings when they were created (and not changed versions).

User Presets - are where you can create and save your own presets, which

would also show up in Recent after you use it.

Inspecting the Results of Processing

A You need to understand when VocAlign Ultra automatically processes (which

helps speed up your workflow):
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« Ifthereis a Guide already captured, as soon as a Dub is
captured, VocAlign Ultra automatically processes the Dub with the
selected preset and creates a new Output.

o Or, if thereis a Dub present and the preset is changed, VocAlign Ultra
will reprocess the Dub with the new preset setting and create a new
Output.

The Output appears in the bottom of the three default waveform views, as a
solid yellow waveform overlaid with a blue outline of the Guide waveform to show time

alignment of the Output relative to the Guide.

OQUTPUT

Ready

Further visual confirmation of the time and pitch alighment can be seen in the pitch
view, shown against the piano keyboard note grid, with the yellow

Output pitch trace alongside the blue and orange Guide and Dub pitch traces.

These pitch traces can be individually turned on or off with "eye" switches to provide a

clear understanding of the changes both needed and made.
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NOTE: Immediately after starting VocAlign Ultra, when the screens are empty, if you
select a preset before capturing the first Guide and first Dub, you won't be able to
adjust any of VocAlign Ultra’s controls until a Guide and Dub have been

captured. However, the selected preset will be applied automatically as soon as the

Dub is captured.

The Guide and Dub aren’t part of the preset, so you don't have to recapture them
when you select a new preset. Changing preset with a Dub and/or Guide clip loaded
reprocesses the Dub instantly according to the parameters of the new preset to create

a new Output.

A WARNING: If you are going to use a different preset on a new Guide and Dub, if
you change the preset before you capture the new Guide, it will be applied to the
current Dub, which you might not want to happen.

46



VocAlign Ultra User Guid

TIP: Change presets as much as you want only after you capture a new
Guide, not before.

Modifying the preset

Be sure to try modifying the controls and see what happens in the timing and pitch
displays as well as in the sound. You may find you need to make at least minor
adjustments to the controls to make a new preset to adapt to your source material. If
you do that and want to keep that preset, save it as a User Preset with a good

descriptive name.

Manually Changing Control Settings

Overview

VocAlign Ultra has two versions of its right hand control panel: Basic and Advanced.

You will sometimes need to make at least minor adjustments to the controls after starting
from your chosen presets' to adapt the processing better to your source material, or modify
the results you hear in the Output to get a better or different results.

Often, you won’t need to go beyond the default Basic control panel to get what you need.

The Advanced control panel is useful to learn more about, because everything you can

change that affects the whole signal is shown here.

Basic Mode
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Basic mode offers just three controls: Max Difference [Match Timing], Tuning Match [Match
Pitch] and Formant Shift.

£

B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

@ @

LOOSE TIGHT
33 ms

B SmartAlign

@ FORMANT SHIFT

If MATCH TIMING is ON:

Max Difference: Determines how tightly the timing of the Dub is aligned to that of the
Guide, from perfectly locked at the Tight (fully-clockwise) setting, to deviating by no more
than 200ms at the Loose (fully-anticlockwise).

As you would expect, when the timing difference between similar events in the Guide and

Dub is less than the Max Difference, no time alignment is applied.
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NOTE: When the timing difference is set to less than TIGHT (Oms) less editing will be

done and the signal will retain more of its original variations from the Dub.

If MATCH PITCH is ON:

The control under MATCH PITCH will be one of two different controls, either Max
Difference or Tuning Match, depending on an Algorithm switch in the Advanced controls

(which will be discussed later).
Max Difference: (Tight/Loose) sets maximum allowed offset in pitch differences.

Tuning Match: When the algorithm setting (in the Advanced control page) is Mode 2 the
Max Difference control becomes Tuning Match. Designed for use with Dubs that whose
pitch is fairly close to the Guide’s pitch, this aligns long term average pitch of the Dub to
that of the Guide when Tight (100%) or keep the Dub average pitch when Loose (0%).

Formant Shift: If ON, at the centre (0%) the Formant knob has no effect. Twist it
anticlockwise to lower the resonances’ frequencies of the Dub signal, making a vocal

sound more ‘masculine’, or clockwise to raise them, for a more ‘feminine’ tonal character.

The algorithms at work behind each of these three top-level parameters are more
controllable in Advanced editing mode , which is discussed in depth in the section User

Interface and Operation.

Saving and managing presets
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To save all the current VocAlign Ultra control settings as a new preset, click the preset

menu and select Save As Preset, then give your preset a name and click Save.

Selecting Manage User Presets from the same menu opens the user preset folder in

macOS Finder or Windows Explorer, where you can rename and back up your presets.

Recent P |ming & Pitch

Dialogue > |1 33|1
Instrument

Rap

Vocal

Default Tight Timing

User

Save As Preset... h Chorus(3)

Manage Users Presets

Previous Next
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6.4. User Interface and Operation

e Using VocAlign Ultra
e Interface overview
e Audio alignment

e How to check that the Dub is aligned with the Guide

Using VocAlign Ultra

Now that you’re up to speed with the fundamentals of VocAlign Ultra — importing and
exporting audio, loading presets and the Basic editing controls — let’s get into the details,
looking at preset management, the three Display switches (at the bottom of the screen),
the Advanced editing controls and more.

Interface overview

The VocAlign Ultra interface is divided into two main sections.

e The left-hand side contains the Guide, Dub and Output Capture/Render controls

and displays.

e Theright-hand side is home to the Basic and Advanced controls that guide the

all-important alignment algorithms.

Note that there will be differences in the left side's Guide, Dub Capture and Output

Return controls, because these depend on the way your DAW exchanges audio with
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VocAlign Ultra. The three different audio capture and return methods are AAX (Audio
Suite), VST and AU Realtime capture, and VST and AU ARA2 capture.

Below is the left side of the AAX interface.

VOCAIign ULTRA Vocal - Double - Slightly Loose Timing & Pitch

0:00:37.000 0:00:38.000 0:00:39.000

Sync Points

Protected Areas

OUTPUT

oo NI —

Because the ARA, VST and AU versions of VocAlign Ultra support sequential capturing of
multiple regions along the session timeline for independent alignment, there is an extra
panel at the bottom which displays an overview of the captured Guides and Dubs along the

timeline.

Tiny Heart Tuned

\” Lead vox Hish Chorus(3)
Delete

VST3 (ARA)
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The overview shows the currently selected Guide and Dub signals in Blue and Orange,
and all the not-selected regions in grey. Click anywhere in the overview to change the
region selection, immediately jumping to it in the main display and updating the

controls accordingly. Click the bin/trash icon at the left-hand end to clear the selected

region from the plugin.

When working with multiple Guide and Dub tracks in the ARA version of VocAlign
Ultra, you can select each track by right-clicking on the Guide or Dub display and

mousing over Select Audio.

VOCAIig N ULTRA *Vocal - Double - Slightly Loose Timing & Pitch v

0:00:40.000 0:00:50.000 0:01:40.000 0:02:30.000 0:03:20.000
Ny HeaT ilrack

Sync Points
v_2(3)

Add Protected Area

Automatic Sync Points

Add Sync Point

Select Audio Tiny Heart Tuned Lead Vocal(3)-24b
y Bv_1(3)

Protected Ar

OQUTPUT

[
Ready
v Bv_2(3)

W = Lead vox High Chorus(3)
|T1'ny Heart Track

_m_ Bv_203)

Delete

NOTE: In the ARA versions, clicking in the Overview (or main) displays will move the
Playhead in the DAW to the clicked position. This is useful for many reasons described

later.

Along the top of the interface are the preset menu, the Basic/Advanced edit mode

toggle, and the Settings and Help buttons.
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Clicking the Settings ﬂ will open the settings panel. It is worth noting here that you can

change the top axis in VocAlign to display Bars and Beats, Time, or Samples. Select

whichever best fits the current session you are working with. The rest of these options will

be covered in detail in Adjusting the Automatic Time and Pitch Matching and Saving
VocAlign Ultra's Audio Data.

VocAlign Ultra Version: 1.1.0.5

Guide Overlay: H Save Audio In New Sessions: B

Show Only Channel 1 Audio: B Save Audio In Current Session: B

Top Axis Units: Bar Beat

Audio Cache Location:

All audio data will be saved in the DAW's Current Session

The interface is freely resizable to suit any size or resolution of monitor by dragging

the bottom right corner or sides, depending on the DAW and OS.

Below, we have compressed the width.
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Voc/.\lig N ULTRA  Vocal - Double - Slightly Loose Timing & Pitch
171 25(1 33)1
1
Tiny Heart Tuned Lead Vpcal(3)-24b = B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

LOOSE TIGHT
i 33 ms
DUB ead vox High Chorus(3)

B SmartAlign

B FORMANT SHIFT

OUTPUT

|
Ready ’

s o

Tiny Heart Tuned Lead Vocal(3)-24b

]

Delete

VST3 (ARA)

And below, we have compressed both the width and height.
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Editor
Vocal - Double - Slightly Loose Timing & Pitch

iny Heart Tuned Lead Vocal§3)-24b

ead vox High Chorus(3)

This shows that the Basic or Advanced control panels can shrink out of sight, while the
Guide, Dub and Output displays adapt their shape and size to fit the remaining

defined space.

This is useful if you have a lot of tracks on the screen that you need to see and are

happy to operate the plug-in with the Presets alone.

Guide, Dub and Output display modes

The display section offers three modes of visualising the Guide, Dub and Output

signals, selected using the three buttons at the bottom.

From left to right these are the Waveform display, the Pitch display, and the Energy

Display (similar to the main display of the previous VocAlign products).
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In all three modes, the Output visualizer updates to reflect changes made to
parameters as they're applied. Consistent colour coding is used throughout the three

views: blue for the Guide, orange for the Dub, and yellow for the Output.

Incidentally, although you'll likely be using VocAlign Ultra with mono signals the vast
majority of the time, multi-channel signals - 2-channel stereo to 7.1 surround -are
also supported, with all channels stacking up in the display. Note that channel 1 (the
left channel in a stereo pair, for example) is always used as the alignment source: Dub
channel 1 is aligned to Guide channel 1, then all subsequent Dub channels are aligned
using the same calculation. Also, only channel 1 shows the Guide outline, Protected

Areas, Sync Points and red processing activity line.

Waveform Display:

The default view shows separate waveforms for each of the three signals.

The Output waveform is overlaid with an outline of the Guide waveform, making it
easy to assess the temporal alignment applied by the current parameter

configuration.

The two blue lines in the Guide and Dub tracks show the result of the "thinking" that
the time matching alignment algorithm has done, by showing where a time position of
features in the guide waveform match the time position of similar features in the Dub
waveform. These floating blue Offset Indicators follow movement of the mouse
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pointer over either waveform, showing the continuous mapping of the position under

the pointer to its counterpart in the other waveform.

VocAl |g N ULTRA  Vocal - Double - Slightly Loose Timing & Pitch

0:00:50.500 0:00:51.000
Tiny Heart Tuned Lead Vocal(3)-24b

DUB Lead vox High Chorus{3)

OUTPUT

Ready

Pitch Profile Display

While the Waveform and Energy Profile views are intended for visualizing alignment in
the time domain, the The Pitch Profile view - you won't be surprised to learn -
provides equivalent information in the frequency domain. A piano keyboard down the
left hand edge represents pitch on the Y axis. Lastly, to provide a familiar timing
reference for the pitch traces, the Guide waveform is included as a grey waveform in

the background
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Each signal is represented in the Pitch Profile window by a line in its usual colour — blue for
the Guide, orange for the Dub and yellow for the Output — that tracks its pitch progression

over time.

See the Quick Start Guides for information on how to put this to use. Clicking the colour-

coded ‘eye’ button E in the Guide, Dub or Output header toggles that signal’s pitch

profile line on and off.

At the very bottom of the Pitch Profile window, the greyscale ‘heat map’ provides insight
into the amount of processing being applied to the Dub along the timeline. This is useful for
auditioning the Output, allowing you to focus your attention on the lightest areas showing

the greatest changes.

Energy Profile Display
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The Energy Profile view (which will be familiar to users of VocALign Pro or Project)
displays the Guide and Dub as solid energy contours over time, and the Output energy
as a yellow trace over the Guide. Again, the Offset Indicators show the temporal

mapping of Guide to Dub, as described above.

0:00:41.975 0:00:43.975 0:00:45.975
Tiny Heart Tuned Lead Vocal(3)-24b

DUB

Lead vox High Chorus(3)

OUTPUT

Ready

Scrolling in the display

In all three display view modes, a horizontal scroll bar at the bottom of the display (as seen
in picture above) enables horizontal scrolling; and the Pitch Profile view also allows for
vertical scrolling via a vertical scrollbar on the right hand edge of the display. You can scroll

with your mouse or trackpad, too.
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D:01:00.000

The horizontal zoom control at the bottom right of the display facilitates zooming into and
out of all three views on the X axis, applied to all panes collectively.

Vertical zooming is handled on a per-pane basis, however: click the small level control icon

H at the top right of any the three Waveform view panes, two Energy Profile view
panes, or the Pitch Profile display to reveal the vertical zoom slider for that pane. Use the
mouse wheel or drag the pop up control up and down to scale the height of the Y axis.

To zoom all waveforms or energy profiles together, hold down the Shift key when you click

ﬂ and then click directly on the pop-up slider and move it up or down.

This increase in the waveform height is only visual and the gain of the audio is not

affected.

Audio alignment
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While you won't often need to go any deeper than the Basic editing mode to get the

desired alignment of your Dub to your Guide, VocAlign Ultra’s Advanced editing
mode and other controls offer plenty of scope for manipulating the algorithms and

processing when tweaking is required.

Before continuing, please refer back to the section on capturing the Guide and Dub for
your particular DAW if you’re not yet familiar with how to get audio into the plugin. Then, if
VocAlign Ultra is in Basic editing mode, click the Advanced edit mode button to reveal the

controls we're now going to explore.
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LOOSE TIGHT
33 ms

Alignment Rule

Normal Flexibility

B SmartAlign
Max Shift No Limit v

B High Resolution

B FORMANT SHIFT
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Advanced 0

B MATCH PITCH

Max Difference Pitch Target
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LOOSE TIGHT DUB GUIDE
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Algorithm Target Mode

Mode 1 Nearest Octave v

Transpose
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These menus are shown in the figure above. You can optimise VocAlign Ultra’s pitch
detection algorithm for specific "unnormal” source signal types by focusing its attention on
higher or lower ranges. You can do this by making appropriate selections in the Guide and

Dub menus.
By targeting the algorithm independently to each of the two signals, you can ensure the
best results possible, whether you’re aligning a lead vocal with a harmony an octave

above, say, or a lead guitar to a bassline.

The available ranges are explained in the next section here

How to check that the Dub is aligned with the
Guide

VocAlign Ultra’s three display views provide comprehensive visualisation of the Guide,

Gub and Ouput signals.

To check the timing alignment of the Dub with the Guide, focus on the Output display

in the Waveform view.

OUTPUT

Ready ”*
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This layers the Guide (blue waveform outline) and Dub (yellow solid waveform) on top of

each other, giving an excellent overview of their positional relationship.

The Energy Profile is also helpful here, and offers a “legacy” view option of alignment

quality as a counterpart to the waveform display.

To check the pitch matching (which also shows the time matiching of the pitch traces),

switch to the Pitch Profile view.

.that lam Lead

f

OUTPUT ©

Ready

Here, the Guide, Dub and Output signals are shown together on a sequencer-style piano
roll, with the Guide waveform in the background for timing reference and a greyscale
processing heatmap at the bottom. As you raise the two Max Difference controls, you'll see
the yellow Output trace move increasingly close to the Guide trace on the X (Match Timing)
and Y (Match Pitch) axes, which can make this the most effective view when working with

sung vocals or melodic instrumental parts.

In the above display, it is set to slightly loose time and pitch, meaning the Output (yellow) is

closer to the Guide (Blue) than the incoming Dub (red), allowing natural variations to come
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through - which differences could be "dialed out" by turning the Timing and Pitch knobs

towards the "Tighter" setting.

Visual references aside, of course, the best way to check the alignment of your Dub is to
audition the Guide and Output signals using the Preview and Solo buttons in the AAX

AudioSuite version,

) o) I‘))

or playback and the Solo controls in the host DAW in all other versions.

Start and End Markers

At both the start and end of the Guide and Dub signals, the white vertical markers with
triangles at the bottom define their Start and End points, as used by the processing

algorithm to work out their alignment.

GUIDE ITiny Heart Tuned Lead Vocal(3)-24b

-2] Capture

DUB Lead vox High Chorus{3)
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If your Guide and Dub start and end at roughly the same points on the timeline, you
probably won't need to touch these. However, if you have, say, a loud breath sound or
cough before the vocal starts in one signal but not the other, moving that signal’s Start
Marker past the offending intrusion will prevent the algorithm misinterpreting it as the start

of the vocal.

However, if the Dub continues beyond the end of the Guide, VocAlign Ultra will simply add

the extra Dub after the Guide ends, unless you move the Dub's end marker.

If the Guides is longer than the Dub, however, you might wish to move the Guide's end
marker to the end of the corresponding Dub audio, to keep the Dub from being stretched

unnaturally to match the continued energy of the Guide.

To move the Start and End Markers, drag their triangular handles or the vertical lines.

Sync Points

Although SmartAlign and the time alignment algorithm at the heart of VocAlign Ultra can be
relied on to accurately match Guide and Dub signals, when some localised differences
between the two signals cause mismatching of similar sounds, you can nudge specified
points in the two signals towards each on the timeline other by manually adding Sync
points. Automatic adding is also available, but generally that will not know what you want to

fix.

To add Sync Points manually, switch to Advanced edit mode and click inside the Sync
Points bar in between the Guide and Dub displays at roughly the point in the Dub that you
want to alter the alignment of. Alternatively, you can right-click in the display and select
Add Sync Point. A pair of connected Sync Point markers will appear in the Guide (blue)

and Dub (orange). Drag each one to the position in their corresponding signal that you
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want to align to try and ‘pin’ the Sync Point in the Dub to its paired Sync Point in the Guide,

intelligently stretching and compressing the Dub on either side to maintain alignment.

0:01:02.600 0:01:02.700

Tiry Heart Tuned Lead

Lead wax High Chorus-24b,wav

Protected Areas

We say ‘try’, as the Sync Point alignment isn’t absolute — it's more of a suggestion, on
which the algorithm will base the decisions it continues to make. As we said, Sync Points
let you influence the alignment of the Output, rather than take full ‘warping’-style control of
it. Indeed, if you set Sync Points that the alignment algorithm can’t achieve without

adversely affecting the audio on either side, they’ll turn red and be ignored.

Sync Points can also be created automatically: right-click in the display and select
Automatic Sync Point. VocAlign Ultra will place Sync Points where it thinks they need to

be, so if your Guide and Dub are already well matched, nothing will happen.

To delete a Sync Point, Shift+click it. To delete all Sync Points, right-click and select Clear
all Sync Points.

Sync Point placement tips
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Protected Areas

e Don’t add Sync Points to silent parts of the Dub. The results will be unpredictable.

Try to anchor them to a voiced part of the Dub and Guide.

e Use multiple Sync Points to force the alignment of a section of the Dub to a section
of the Guide. Placing one Sync Point at the start of the section and another at the

end usually works well.

e Refine the alignment further by adding more Sync Points before and after each.

e To maximise the influence of Sync Points, set the Match Timing Alignment Rule to

Normal or High Flexibility.

Protected Areas

When your Dub contains one or more sections that contains different audio than the
Guide and you do not want to have time or pitch matching in these areas, you can

define Protected Areas, rendering them ‘immune’ to processing of the Dub's timing,
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pitch or both. This is also useful if there are distracting noises in the Guide which

would cause unwanted time or pitch changing.

To create a Protected Area, switch to Advanced edit mode, if you haven'’t already, and drag
on the Protected Areas bar across the range within the Dub to be protected. The Protected
Area appears as a red highlight, resizable by dragging the ‘shield’ handles at either end,

within which no processing is applied to the Dub.

GUIDE Tiny Heart Tuned Lead Vocal(3)-24b

Sync Points
DUB Lead vox High Chort @ﬂ

By default, a Protected Area is protected from both pitch and timing alignment changes,
but this can be narrowed to pitch or time by right-clicking the Protected Area and selecting
Modify Protected Area > Protect Pitch or Protect Time. The clock (time) and musical
notes (pitch) icons at the top left of the Protected Area show whether it's protected from

pitch, time or both.
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Modify Protected Area
Delete Protected Area - Protect Timing

Automatic Sync Points ~ Protect Pitch
Add Sync Point

Max Shift No Limit v

B High Resolution
If you zoom in to either end of a Protect Pitch Area, you'll see that it slopes outward. This
indicates the smooth skewing of pitch alignment into and out of the Protected Area,
thereby ensuring that there are no sudden and unnatural jumps in pitch when processing

stops and starts.

You can also create a Protected Area by right-clicking the Dub and selecting Add

Protected Area > Protect Pitch and Timing, Protect Pitch or Protect Timing.

Previous Next
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6.5. Using SmartAlign

SmartAlign

VocAlign Ultra 1.1 adds SmartAlign as an option in the Match Timing section of both

the Basic and Advanced modes as shown in the pictures below.

IMPORTANT NOTE: .

ﬂ SmartAlign will automatically be enabled in VocAlign Ultra 1.1 in all the Presets (except in a few
cases, which are identified in the preset name)

R ?

B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

LOOSE TIGHT LOOSE TIGHT
33ms 20%

B SmartAlign

FORMANT SHIFT
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Advanced {:}

B MATCH TIMING Bl MATCH PITCH

Max Difference Max Difference Pitch Target

@ e. ®

LOOSE TIGHT LOOSE TIGHT DUB GUIDE
33 ms 20% 100.0 %

Alignment Rule Algorithm Target Mode

Normal Flexibility Mode 1 Nearest Octave ¥

2 Transpose
B SmartAlign

Max Shift No Limit w
HIGHER

00
High Resolution

FORMANT SHIFT PITCH RANGES

Guide Normal

Dub Normal

When SmartAlign is enabled, the system looks for "matchable" audio in the Dub
track and then looks in the Guide track to see if there is also "matchable
audio". If there is, and Match Timing and/or Match Pitch are also on, the the
matchable Dubs regions will be aligned to the corresponding Guide regions.
Where there are not Dub and Guide signals that can be "matched", the
alignment processing will generally leave the Dub audio alone, for example, not
processing long gaps of silence in either.

SmartAlign helps to avoid the need to break up longer sections into segments
for processing. SmartAlign is particularly useful when working with complex
vocal arrangements.
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VocAlign U

Let's walk through an example.

In the screenshot below, we can see two audio tracks labelled Lead Vocal and
Lead Vox High Chorus.

Tuned Lead Vocal will be our Guide track, and Lead Vox High Chorus will be the
track to be aligned, called the Dub track.

PlLead vox High Chorus() Lead vox High Chorus(2) PLead vox High Chorus

Lead Vox High Chorus Ay

v o
W None v
& Lead Vox High Chorus 1 v

In earlier versions of VocAlign, it would be necessary to cut the Guide track
(Lead Vocal) to ensure that it has roughly the same start and end time as the
Dub track. This workflow is still available.

But we can now use SmartAlign to quickly work with more complex vocal
arrangements without needing to cut and aligh segments.

First we will show capturing our Guide and Dub track's audio into VocAlign
Project 5. This will be explained in detail in later chapters for different DAW
interfaces.

Below you can see our Guide in blue (Lead Vocal), with our Dub track in orange
(Lead Vox High Chorus) and the automatically Aligned Dub as the Output
waveform in yellow correctly positioned in the timeline.
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VQcAlign ULTRA  *Vocal - Double - Slightly Loose Timing & Pitch

0:00:00.000 0:00:50.000 :01:40.000

iny Heart Tuned Lead Vocal(3)-24b

ead vox High
horus(2)

B MATCH TIMING

Basic fol ?

B MATCH PITCH

Max Difference Max Difference

LOOSE TIGHT LOOSE TIGHT
33ms 9

B SmartAlign

B FORMANT SHIFT

OUTPUT

Ready »”

Tiny Heart Tuned Lead Vocal(3)-24b

0]

Delete

VST3 (ARA)

Previously, without SmartAlign, VocAlign would attempt to output our Dub
aligned with the beginning of our Guide region.

This is shown below, where we can see the Output waveform in yellow, which is
not correctly lined up with the original location of our Dub track.

Voc/.\lign ULTRA  Vocal - Double - Slightly Loose Timing & Pitch

0:00:00.000 0:00:50.000
iny Heart Tuned Lead Vocal(3)-24b

DUB

OUTPUT

Ready U () n

W =

:01:40.000
B MATCH TIMING

Max Difference

X LOOSE TIGHT
ead vox High 33 ms

horus(2)
B SmartAlign

Basic o 'l

B MATCH PITCH

Max Difference

20%

B FORMANT SHIFT

Tiny Heart Tuned Lead Vocal(3)-24b

W

Delete

VST3 (ARA)

Remember, SmartAlign will be ON in almost all the Factory presets available.
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But if you find turning it off useful, you can save that preset as a User Preset to
access for further use.

Working with Large Arrangements

With SmartAlign and the AU and VST3 ARA versions of VocAlign Ultra, it is possible to

quickly capture multiple dubs for individual alignment.

With a SmartAlign-enabled preset chosen or SmartAlign enabled, select the audio
regions you would like to work with in your DAW. Enable the VocAlign Event FX as in
Step 1 above, and then with the regions still selected, click the Dub Capture button.
Depending on the number of regions selected and the speed of your computer, the
capture process could take a few moments. We recommend capturing less than 4

regions or 8 minutes of audio at once to if you wish to avoid longer processing times.

When working with multiple Guide and Dub tracks in the ARA version of VocAlign
Ultra, you can select each track by right-clicking on the Guide or Dub display and

mousing over Select Audio.

VocAIig N ULTRA  *Vocal - Double - Slightly Loose Timing & Pitch v

0:00:¢0.000 0:00:50.000 0:01:40.000 0:02:30.000 0:03:20.000
iy HeaT flack

Sync Points
v_2(3)

Add Protected Area

Automatic Sync Points

Add Sync Point

Select Audio Tiny Heart Tuned Lead Vocal(3)-24b
Wi ¥ Bv_1(3)

Protected At

OUTPUT
3

Ready
v/ Bv_2(3)

W &= Lead vox High Chorus(3)

|T1'ny Heart Track
bv_ZiS]




VocAlign Ultra User

Limitations of SmartAlign

SmartAlign uses the presence of audio in your Dub to align itself to the Guide track,
and although it functions very reliably, you may on occasion need to resort to the non-

SmartAlign workflows outlined in this manual.

Although with the addition of SmartAlign the audio region/clip start time do not need
to be the same, SmartAlign expects that the audio signal (the voice or
instrument signal) present in the Guide and Dub will start within 0.25 seconds of each

other.

Please see the below example, wherein yellow would be our Guide audio, and red our

Dub.

In the below image, we can see that the yellow and red regions have very different
start times, but the audio is fairly closely aligned. SmartAlign will be able to easily work

with the below audio.

"me Heart Tuned Lead Vocal(3)-24b
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In this next image, we can see that the yellow and red regions have the same start

time, but the audio signal is significantly misaligned. Because SmartAlign expects our
waveforms to be within 0.25 seconds of each other, we would need to manually move
the red audio waveforms to be a little bit better aligned with the yellow waveforms

before continuing with VocAlign and SmartAlign.

PTiny Heart Tuned Lead Vocal(3)-24b
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6.6. Adjusting the Automatic Time and Pitch Matching

Capture Sequence

Advanced Display

Match Timing Advanced controls
Match Pitch Advanced controls

Other Controls

Capture Seqguence

A\ If you are going to use a different preset on a new Guide and Dub, if you change

the preset before you capture the new Guide, it will be applied to the current
Dub, which you might not want to happen.

Here is the safest order to do your operations:

1. Before you move on to capture a new Guide, don't change the preset!!
2. Capture your new Guide
3. Change the preset now (if you want to)

4. Capture the Dub

Basic Display

VocAlign Ultra’s Basic edit mode gives you fundamental control of the timing and pitch

alignment setup defined by the currently loaded preset, via just two knobs.
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Basic {}

B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

@© @

LOOSE TIGHT
33 ms

B SmartAlign

B FORMANT SHIFT

Match Timing

The Max Difference knob in the Max Timing section sets the size of the ‘window’ of
allowable variation in timing between the Guide and Dub's detailed audio events, from
200ms to Oms. In essence, the further clockwise you turn Max Difference, the tighter
the alignment becomes, all the way to totally locked at the fully-clockwise ‘Tight’ end of

the knob’s range.
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Below the Max Difference knob is the button to enable SmartAlign. For detailed

information on SmartAlign, click here.

For typical operation, you should leave SmartAlign enabled. If you find that something
is working in an unexpected way, try disabling SmartAlign and using the non-
SmartAlign workflow for your DAW, as outlined in the Quick Start guides at the end of

this manual.

Match Pitch

For most presets (Mode 1), the Match Pitch control operate just like its Match Timing
equivalent, but in the pitch domain: turn it clockwise from Loose towards Tight to push

the pitch profile of the Dub increasingly close to that of the Guide.

However, when a preset with the Mode 2 suffix is loaded, the Max Difference knob
becomes Tuning Match. Mode 2 presets are designed specifically for delivering
smoother Ouput with vibrato-heavy Dubs, and require the Guide and Dub to be

closely matched in terms of average pitch.

The Tuning Match control progressively matches the time-variable average pitch of
the Dub to that of the Guide, thus achieving alignment without compromising the

naturalness of the vibrato.

Formant Shift

The Formant Shift control raises or lowers only the particular harmonically

related resonances defined by the size and shape of the vocal tract, enabling you to
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change the timbre of a vocal without affecting its pitch. Turn it anticlockwise to make

your singer or voiceover artist sound more ‘masculine’, and clockwise to make them

sound more ‘feminine’.

Advanced Display

To be clear, even when the VocAlign Ultra GUI is in Basic Display mode, the Advanced
mode controls are still ‘active’. We've just hidden them from immediate view, as the
idea is to only use them when the Basic mode controls aren't quite getting you where

you need to be with your alignment.

To switch to Advanced edit mode, click the Basic button, top right. The button will

change to ‘Advanced’ - click it again to switch back to Basic mode.

You may have noticed by now that a VocAlign Ultra preset is a simply combination of

specific settings of all the controls in the Advanced display.

The presets were created by considering the typical signals that sound editors work
with. These presets have a heirarchy of names which define specific roles of the

signals, tasks and desired results, which together become the name of that preset.

If you find that changing one of the controls differently from a preset gives you the
Outputs you want, your new setting can be saved as a User Preset and retrieved in

the future for use with similar signal types.

Match Timing Advanced controls
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B MATCH TIMING

Max Difference

LOOSE TIGHT
33 ms

Alignment Rule

Normal Flexibility

Bl SmartAlign

Max Shift No Limit ¥

High Resolution

B FORMANT SHIFT

LOWER HIGHER
0.0 %

Alignment Rule

The selection in this drop down menu determines the amount by which the internal

editing system is permitted to time stretch and compress the Dub.

o Lowest/Low Flexibility: The editing algorithm is only allowed to make small

adjustments to the Dub, so alignment will comparatively ‘loose’
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Normal Flexibility: This is the setting you should always try first, as it will be

the most effective one in most cases.

High Flexibility: The algorithm is allowed to stretch and compress the Dub
much further than Normal Flexibility, resulting in comprehensive alignment at
the possible expense of compromised sound quality - there’s only so far an

audio signal can be stretched before it starts to degrade.

Maximum Compression: The algorithm is allowed to compress the aligned
audio as much as required to align it, but stretching is limited to the same
amount as the Normal Flexibility setting. This setting should only be used when
the timing of the Dub is way off - think of it as an extreme fix for use when all

else fails.

Maximum Expansion: The algorithm is allowed to stretch the aligned audio as
much as required to align it, but compression is limited to the same amount as
the Normal Flexibility setting. Like Maximum Compression, this is a setting you'll

only want to use in the most extreme cases.

Normal Flexibility + Pitch: Intended for use with legato voicing, where the
pitch of the Guide and Dub varies over time, but their energy doesn't. The

algorithm uses pitch changes as the basis for alignment.

Max Shift

Mainly used for use with ‘Dubs with Gaps" and SmartAlign OFF, the Max Shift

parameter sets the maximum amount of time (from 10-150ms) that the editing

algorithm is allowed to move any given point in the Dub from its original position. This
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is helpful for preventing audio that starts at the end of a gap in the signal from being

erroneously matched to the gapless Guide and thereby moved too far forward.

High Resolution Editing

Upsamples the audio to 384kHz for the internal editing process, preventing certain
rarely encountered artifacts at the expense of additional processing time. This is
mainly helpful in editing more "pure" tonal signals such as high female voices, flutes,

bell sounds and so on.

Match Pitch Advanced controls
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B MATCH PITCH

Max Difference Pitch Target

LOOSE TIGHT DUB GUIDE
20% 100.0 %

Algorithm Target Mode

Mode 1 Nearest Octave ¥

Transpose

HIGHER
0.0

PITCH RANGES

Guide Normal

Dub Normal

Pitch Target/Details Matching:

The Pitch Target control simply specifies how closely the Dub is aligned to the Guide
in pitch - from 0% (Dub) to 100% (Guide).

For Mode 2 presets, Pitch Target becomes Details Matching, determining how tightly

short fluctuations in pitch - ie, vibrato - are aligned.

Algorithm
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Switches between the ‘regular’ Mode 1 editing algorithm and the vibrato-friendly

Mode 2, as described above.

Target Mode

Only accessible in Mode 1, Target Mode governs the general purpose of the pitch

correction used by the matching algorithm.

e Nearest Octave: This setting ensures that the Output Dub stays in its original
range (i.e. same octave(s)) when aligned with a Guide whether it is in the same
or different octave. It should be the default setting in most cases and will work
with octave-apart doubles, or aligning female dialogue to male dialogue or vice

Versa.

e Absolute: The algorithm does its best to match the Guide and Dub directly,

pulling the Dub's pitch to the Guide's as far from its original pitch.

e Relative: Imposes the pitch modulation profile of the Guide onto the Dub -
when the Guide rises or falls in pitch, the Dub is made to to the
same. Essentially, the Dub follows the time varying average pitch of the two
signals. This one is a good choice for an actor overdubbing their own dialogue,
ensuring that the original intonation pattern is maintained whether or not the

pitch is higher or lower.

¢ Monotone: Included purely for creative purposes, Monotone Target Mode
snaps the Dub to a single constant pitch (calculated from the average), and

adjusted using the Transpose control.
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Transpose

Pitch shift the Output Dub by up to 1200 cents (one octave) up or down.

Pitch Ranges

Set these two self-explanatory fields to the most appropriate option for your Guide

and Dub source material to optimise the editing algorithm.

Normal: The default ‘general purpose’ setting, for spoken word, vocals in non-

extreme registers and the majority of instruments.
e High Pitched Vocal: Sung vocals in ‘higher-than-average’ registers.
e Low Pitched Vocal: Sung vocals in ‘lower-than-average’ registers.

¢ High Pitched Instrument: High-frequency-dominant instruments such as

violin, flute, lead guitar, lead synth, etc.

e Bass Instrument: Low-end instruments such as electric and acoustic bass,

cello, bass synth, etc.

Other Controls

Open Settings
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Clicking the cogwheel button reveals various preferences.

VocAlign Ultra Version: 1.1.0.3

Guide Overlay: W Save Audio In New Sessions: W

Show Only Channel 1 Audio: m Save Audio In Current Session: |

Top Axis Units: = Time

Audio Cache Location:

/Users/ /Music/VocAlignUItraVst3/AraAudioCache/
2021-09-12 13-29-21

e Aligned Overlay: Hide and reveal the Guide overlay in the Output section of the

Waveform display.

e Show Only Channel 1 Audio: When signals of two channels or more are being

aligned, activating this option hides the waveforms of all but the first channel of each

signal, reducing visual clutter.

e Top Axis Unit: Switch the scale on the X axis of the display Waveform/Energy/Pitch

Profile view display between Time and Samples or Bar/Beats in some DAWS.

Open Help
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Open the online version of this User Guide and/or the Quick Start Guide for your DAW in
your browser.

Previous Next
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6.7. Saving VocAlign Ultra’s Audio Data

e Overview of Saving VocAlign Ultra Audio

e Archiving Audio in the DAW's Session

e Configuring VocAlign Ultra to Archive its Audio in the DAW's Session
e Saving Audio to a Local Directory

e Configuring VocAlign Ultra to Save its Audio to a Local Directory

e Location of VocAlign Ultra’s Local Directories

e Structure of VocAlign Ultra's Local Directory

ﬂ This Chapter is ONLY for VST3 and AU Versions of VocAlign Ultra

Overview of Saving VocAlign Ultra Audio

ﬂ In this document, will use the word Session to mean what your DAW might
refer to as a Project, Song, Session, et

When you use VocAlign Ultra it creates new audio files containing the processed audio

that are used to replace the original Dub audio. So the VocAlign Ultra plug-in puts the

audio first into its own directory on your hard disk, and it has connections to it so it

knows where it is.

After you use this processed audio, technically there is no need to save the aligned

audio to a cache, because VocAlign Ultra can always regenerate its aligned audio

91



VocAlign Ultra User Guide V1.1

output. Nonetheless, regenerating the aligned audio takes time and this means that

the audio may not be ready for replay when you reopen a project.

So saving the aligned audio data allows instant replay on reopening a session and this

section is about the different ways this can be done.

In addition, VocAlign Ultra VST and AU versions give you the choice to make the
processed audio part of your DAW's Session audio by responding to commands like
Render, Bounce to disk, Freeze etc. When you do this, your DAW will take over the
audio, the connection to the audio and dealing with where it is kept and how it is

saved.

In both cases, the processed audio (connected to VocAlign Ultra or rendered and
connected to your DAW) must be saved somewhere known, so when you reopen your

Session, everything processed will be there or be re-creatable.

This section explains that in both cases, these output audio files may become quite
large and, therefore, VocAlign Ultra offers you two ways of saving them. You can

choose either to:

1. Archive the audio data in the DAW's session data or

2. Save the audio in a local directory on your computer.

Each method has its own advantages and drawbacks which will be explained next.

Archiving Audio in the DAW's Session

Advantages
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1. The DAW can manage VocAlign Ultra’'s audio data such that the DAW's filing

operations such as “Save As..” or “Save to New Folder...” will all work seamlessly.

2. If you transfer your session to another computer, all VocAlign Ultra’s audio will

also be transferred correctly.

3. If you remove VocAlign Ultra from your session, all VocAlign Ultra’s audio data

will be deleted from your hard drive.

Disadvantages

1. It may take noticeably longer to save your sessions. The more audio data that
VocAlign Ultra generates in a session, the longer it will take to save it in the
DAW's session.

However, for a typical session, the extra time needed to save the audio data on

modern fast hard drive will be minimal.

Configuring VocAlign Ultra to Archive its Audio in
the DAW's Session

To configure VocALign Ultra so that it saves its audio data in the DAW's session you are

working on, you need to do the following:
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1. InVocAlign Ultra, click on E to open the Settings window shown in Fig.1

below.
2. Click the button next to Save Audio in Current Session so that it ON (yellow).

3. If you would also like all future Sessions to save their data in the DAW's session,
click the button next to Save Audio in New Sessions to be ON (yellow).
This acts like a “preference” setting for the plug-in whenever you open in future

sessions.

VocAlign Ultra Version: 1.1.0.5

Guide Overlay: B Save Audio In New Sessions: W

Show Only Channel 1 Audio: B Save Audio In Current Session: B

Top Axis Units: Bar Beat

Audio Cache Location:

All audio data will be saved in the DAW's Current Session

Figure 1. Configuring VocAlign Ultra to archive its audio in the DAW's session.

Further detail
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While you are working in a Session, you can turn the Save Audio in Current Session

ON or OFF anytime and that will control how that session is saved.

If the Save Audio in New Sessions was set ON prior to your using VocAlign Ultra,
when you open VocAlign Ultra, the Save Audio in Current Session switch will already

be ON.

A\ The Real-Time Capture version of VocALign Ultra (AU) cannot save its audio in
Logic Pro’s project file..

Only the AU (ARA) version can do this. This means that for VocAlign Ultra (AU) you'll not
be able to select the option Save Audio in Current Session in the settings dialogue

box.

Saving Audio to a Local Directory

Advantages

1. Saving sessions is not any slower than normal.

2. If you close the DAW session and restart, the session will find the audio unless

you move or delete it.

Disadvantages

1. The DAW cannot manage VocAlign Ultra’s audio data. The DAW operations such
as “Save As..” or “Save to New Folder...” will not generate new copies of VocAlign

Ultra's Audio data if they are needed.
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2. If you transfer your session to another computer, VocAlign Ultra’'s audio will not

be transferred as well.

3. If you remove VocAlign Ultra from your session, all VocAlign Ultra’s audio data

will still remain on your hard drive.

Configuring VocAlign Ultra to Save its Audio to a
Local Directory

To configure VocALign Ultra so that it saves its audio data to a local directory, you

need to do the following:

1. InVocAlign Ultra, click on ﬂto open the Settings window shown in Fig.2

below.
2. Turn OFF the Save Audio in Current Session switch if it is already ON.

3. If you would like all future Sessions you create to save their audio to a local

directory, you need to make sure that Save Audio in New Session is also OFF.
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VocAlign Ultra Version: 1.1.0.5

Guide Overlay: 1 Save Audio In New Sessions: W

Show Only Channel 1 Audio: B Save Audio In Current Session: B

Top Axis Units: Bar Beat v

Audio Cache Location:

/Users/ /Music/VocAlignUIltraVst3/AraAudioCache/
2021-09-14 17-54-31

Figure 2. Configuring VocAlign Ultra to save its audio to a local directory.

Please Note:

e Ifyou are using Logic Pro, only the AU (ARA) version of VocAlign Ultra (AU) can

archive its audio data in Logic Pro's session.

e The Real-time Capture AU version of VocAlign Ultra will always save its audio

data to the local directory.

e This restriction does not apply to the VST3 version of the plug-in.

Location of VocAlign Ultra’s Local Directories
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You can configure VocALign Ultra to save its audio to a local directory on your hard

drive. The location this directory depends on both which version of VocAlign Ultra and

which operating system you are using:

VocAlign Ultra (VST)
MacOS

The local directory's location is: “/Users/CurrentUser/Music/VocAlignUItraVst3/..”

Windows 10

The local directory’s location is:

“DrivelLetter\Users\CurrentUser\Documents\VocAlignUltraVst3\..”

VocAlign Ultra (AU)

The local directory’s location is: “/Users/CurrentUser/Music/VocAlignUItraAuU/..”

Structure of VocAlign Ultra's Local Directory

VocAlign Ultra will save audio data to its local directory when you have chosen not to

save the audio data in the DAW's session.

Note that the User cannot change this directory location.
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VocAlign Ultra (Real-Time capture)

VocAlign Ultra will create In its local directory, a subdirectory for each new DAW
session. In this subdirectory, VocAlign Ultra will save its “captured” Guide and Dub
audio and any aligned (processed) audio that it generates. See examples in Fig.3

below.

Name ~  Date Modified Size Kind
» Bl 2021-02-0116-28-56 0

B 101 2021-02-02 16-26-46 0 2 Feb 2021 at 17:03 --  Folder
B [ AratwudioCache Today at 10:36 --  Folder

Figure 3. Example of VocAlign Ultra's local audio directory

The subdirectory’s name has the form “year-month-day hours-minutes-seconds
(count)”. For example, the directory “2021-02-01 16-28-56 0" was created on 1

February 2021 at 16.28.56 (4.28 p.m.) The “Count” field is used internally by the plug-in.

VocAlign Ultra will never delete any of these dated and timed subdirectories.
Unfortunately, VocAlign Ultra cannot determine how many of the DAW's sessions (or
projects) still refer to the audio in the subdirectories, so it “plays safe” and assumes

that the audio is still needed.

Should and can | delete these directories?
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If you are sure that none of your DAW sessions refer to any audio generated by

VocAlign Ultra in a subdirectory, then it is safe to delete that subdirectory.
Here's how:

You might be able to use your computer’s directory browser to identify old unneeded
subdirectories. Look at the subdirectory name and the date/time fields as shown

above in Fig 3. You will need to decide what is delete-able.

Another clue is in VocAlign Ultra's “Settings” dialogue box (shown below in Fig.4) which
displays the Audio Cache Location path for the local directory that the plug-in is using
to store its audio for the current session. This may also help you determine which

subdirectories are still in use.

VocAlign Ultra Version: 11.0.5

Guide Overlay: B Save Audio In New Sessions: W

Show Only Channel 1 Audio: B Save Audio In Current Session: B

Top Axis Units: Bar Beat

Audio Cache Location:

[Users/ /Music/VocAlignUItraVst3/AraAudioCache/
2021-09-14 17-54-31

Figure 4. Path of the local directory used to cache the current session’s audio
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VocAlign Ultra (ARA)

Should you choose not to archive audio in the DAW's session, the ARA version of
VocAlign Ultra will save its processed (aligned) output audio to a local directory.

VocAlign Ultra will not save the Guide or Dub audio as it can recreate these from your

DAW session.

To keep the “Real Time” and “ARA” audio separate, VocAlign Ultra (ARA) stores its data

in the directory “AraAudioCache”, which is shown expanded in Fig.5 below.

Name ~  Date Modified Size Kind
= 2021-02-0116-28-56 0 5

B0 2021-02-02 16-26-46 0 2 Feb 2021 at 17:03 --  Folder

¥ | AraAudioCache Today at 10:36 --  Folder
B [0 2021-02-03 14-53-13 4 Feb 2021 at 10:04 --  Folder
[ 2021-02-05 08-41-35 5 Feb 2021 at 08:41 -- Folder
[ 2021-02-05 08-49-42 5 Feb 2021 at 08:49 -- Folder
[ 2021-02-05 08-58-41 5 Feb 2021 at 08:58 -- Folder

Figure 5. Example of VocAlign Ultra (ARA)'s Audio Cache.

Similar to the “Real-Time” versions of VocAlign Ultra, VocAlign Ultra creates a
subdirectory for each session in your DAW. The subdirectory’'s name has the form
“year-month-day hours-minutes-seconds”. For example, the directory “2021-02-03 14-

53-13" was created on 3™ February 2021 at 14.53.13 (2.53 p.m.).

VocAlign Ultra (ARA) will not delete the directory “AraAudioCache” or any of its

subdirectories.
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It is, however, always safe to delete any of the subdirectories as VocAlign Ultra can

regenerate the audio. But if you delete a subdirectory that is still in use then, at worst,
you may have to wait for VocAlign Ultra to regenerate its aligned audio before you

replay the project.

Previous Next
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7. Quick Start Guides for DAWSs
About these Quick Start Guides

Plug-in Types

These Guides are specific to the types of plug-in(s) each DAW uses. Click the link to go

to the referenced Guide.
For AAX (Audio Suite) - Pro Tools only
For AU (Audio Units) - Logic Pro 10 and others

For VST3 - Cubase, Studio One, Live, Reaper, Nuendo, Cakewalk and others

Contents of Quick Start Guides

Each Guide links to a specific Audio Project/Session you can download for many DAWSs,

and then work through a few examples to help you learn the basics of VocAlign Ultra.

Further Detail

You may have already noticed that these Quick Start Guides are contained in the main
VocAlign Ultra User Guide, which you can explore using the Table of Contents on the

left.
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7.1. VocAlign Ultra Quick Start Guide for Pro Tools
AAX Plug-in

Quick Start for Pro Tools using AAX (AudioSuite)

Overview

Installation and Initial Setup
Processing a Harmony Track
Audition the end result

Fixing problems

Quick Start for Pro Tools using AAX (AudioSuite)

Overview

In this Quick Start Guide, you will learn how to set up Pro Tools and VocAlign Ultra to

transfer audio into VocAlign Ultra, process that audio, and have the processed output

returned to Pro Tools.

The procedure might seem a little complex at first, because you have to tell the plugin

which track contains the Guide and which track(s) need their timing and/or pitch

adjusted by VocAlign Ultra to match the Guide's.
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We won't go into details on the control panels or displays here, as those are described

in the 'Using VocAlign Ultra' sections of the main User Guide shown on the left.

One last note: because we started long ago in the film industry, we call the audio to be

modified and output the “Dub”.

Before we let you do the work, here's a video that gives you the basic steps you are

going to learn.

[Updated video for VocAlign 1.1 in Pro Tools with SmartAlign workflow forthcoming]

Installation and Initial Setup

e You should have already downloaded, installed and authorised the VocAlign
Ultra plug-in on your computer.

See Installation and Authorization if you haven't.

e Download the 'No Holding Back' Pro Tools Session and follow along with the

operational instructions below.

e Note that VocAlign Ultra is not a real-time plugin, so it doesn't appear in channel

inserts. It can only be found in the AudioSuite menu.

Let's Start Processing

Here, we'll describe the VocAlign Ultra workflow steps of selecting a preset, capturing

the Guide and Dub signals from Pro Tools, processing the Dub audio and sending the
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processed Output back to Pro Tools. We're using the 'No Holding Back' Session that

you should have downloaded. We'll also look at changing presets and settings.

1. In Pro Tools, open the ‘No Holding Back' Session (download link is given above).

2. Load the VocAlign Ultra plugin by opening Pro Tools' AudioSuite menu,

selecting the Other submenu, then selecting VocAlign Ultra as shown below.

@ ProTools File FEdit View Track Clip Event LI Options Setup Window Avid Link Help

4 e

1 2 3 4 5

- Modulation
| TUNEDLEADVO | Harmanic
o T B m Sound Field
& & wave A DC Offset Removal
MALELEADOCT ~ Duplicate
CO O Gain
£ ¥ wave A= Invert
FEMALEDUBGE ° Normalize
e W PhaseALign
Reverse
Revoice Pro APT
Revoice Pro Doubler
Revopice Pro Link
Signal Generator
Time Compression Expansion
s T8 m VocALign Pro

& ¥ wave A WocALign Project
Backing Music ~

o I|BM wave

b Y Y Y YTYTYTYY

A % wave L
MALE HARM1 ~
¢ T E m
A ¥ wave A=
FEMALEHARM ~

3. VocAlign Ultra should open and look similar to the picture below.

NOTE: You can drag the triangle in the bottom right corner to scale the width and height of

the plug-in window.
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Selection Preset )
VocAlign Ultra playlist USEIN PLAYLIST <factory default>
create continuous file entire selection S COMPARE

multi-input mode no track selected

VOC/\llg N ULTRA *Vocal - Double - Slightly Loose Timing & Pitch

-0:00:05.000

Guide: This track will contain the audio you are matching.

)UB

2 r
?] Capture Dub: This track will contain the audio that will be modified

to match the audio in the Guide track above.

OQUTPUT

Render [5
Output: This track will contain the modified Dub audio.

No Output Press the help "?" button for more instructions.

wx 0

4. In the AudioSuite menu at the top of the plugin, make sure USE IN PLAYLIST is

activated, as shown below.

Salection
VocAlign Ultra playlist " USE IN PLAYLIST
create continuous file entire selection

multi-input mode

5. Play each of the tracks in the Session against the 'Tuned Lead Vox' track to get

an idea of what the parts sound like and what needs to be done to them.
Process your first Guide and Dub with SmartAlign

6. In Pro Tools, select the 'Tuned Lead Vox' clip shown in the picture below. This

will be our Guide audio.
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FIXED LEAD VOX-REFERENCE ONLY

[ oM o pR - Brp- ol

& 0d

MALE LEAD OCTAVE LOWER

» = {5
7. InVocAlign Ultra, click the Guide Capture button to load the selected audio
signal into the Guide section, as shown below. The outline of the Guide

waveform is also shown in the Output track as a timing reference.

VOC/.\|ign ULTRA Vocal - Double - Slightly Loose Timing & Pitch v

0:00:22.000 0:00:24.000 0:00:26.000 0:00:28.000 0:00:30.000

Dub: This track will contain the audio that will be modified
to match the audio in the Guide track above.

OUTPUT

No Output

8. In Pro Tools, select the clip ‘"MALE LEAD OCTAVE LOWER' as shown in picture
below. This will be the Dub audio. When working with SmartAlign, the start

times of the Guide and Dub clips do not need to be the same.
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[0d8

MALE LEAD OCTAVE LOWER

%mmm»nmﬁem—

= 0dB

FEMALE DUB GE

9. The second track is a double of the first (even though they're an octave apart),
so in VocAlign Ultra, select the Vocal - Double - Slightly Loose Timing
& Pitch preset before Capturing the Dub. This ensures that the Dub will be

processed with this setting as soon as it is Captured.

Recent L lming & Pitch v

Dialogue 0:00:26.000 0:00:28.000

Instrument

Rap

Creative

Dub with Gaps

High Pitch Dub

Save As Preset... Low Pitch Dub

Manage Users Presets Legato Voices - Tighter Timing
Slightly Loose Timing & 8ve Pitch
Slightly Loose Timing & Pitch

Slightly Loose Timing & Pitch Mode 2
Dub: This track will contain the atEtoeree.

TS TR T

to match the audio in the Guide track above.

User

In VocAlign Ultra, click the Dub Capture button to load the selected signal into the Dub
section and automatically process the Dub based on the control settings established

by the Preset.

(Note: If this is the first time you have run VocAlign Ultra, it will turn on the process

controls before processing)
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VOCAIign ULTRA *Vocal - Double - Slightly Loose Timing & Pitch v Basic Foy 2

0:00:20.651 0:00:22.651 0:00:24.651 0:00:26.651 0:00:28.651 0:00:30.651
i B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

@ @

LOOSE TIGHT LOOSE TIGHT
20%

B SmartAlign

DUB

B FORMANT SHIFT

OUTPUT

o b

Ready

Process your first Guide and Dub without SmartAlign

If for some reason you need to disable SmartAlign, you can follow the above
instructions, but instead of selecting a clip, you will need to highlight a region of that
clip as shown below. Make sure the highlighted region in the Dub roughly corresponds

with the highlighted region of the Guide.

TIP: Press the ; key to shift the selection range down from the track above. If required

you can Press P to shift selection up.

f Note: It is a good idea to leave similar amounts of silence ahead of the Guide and Dub.

TUNED LEAD VX
+ 0dB I I

MALE LEAD OCTAVE LOWER
+ 0dB

FEMALE DUB GE
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Auditioning and Rendering the Output

f Note: At this point, the audio has been processed but not yet returned to Pro Tools.

The Dub and Output (processed Dub) signal waveforms appear as shown below, and

the parameters to the right are activated and applied.

The Output display at the bottom shows the processed signal waveform overlaid with

an outline of the Guide’s waveform for timing accuracy reference.

The light blue lines follow the mouse pointer along the waveforms to show the
calculated offset between matching features of the Guide and Dub that the settings
are aligning.

Voc/\hg N ULTRA  Vocal - Double - Slightly Loose Timing & Pitch Basic o) ?

0:00:25.500 0:00:26.000 0:00:26.500 0:00:27.000
GUIDE X B MATCH TIMING B MATCH PITCH

3) Capture Max Difference

B SmartAlign

DUB

A5
B FORMANT SHIFT
-] Capture

OUTPUT

«
Ready { | !

You now have three Options:

1. Press VocAlign Ultra's Render button to render the output over the original
Dub, or select an empty track and audition the processed audio in Pro Tools.

Here, we've returned the processed audio to the same track it came from.
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T 0dB T 0dB

FEMALE DUB GE

2. Alternatively, click the Audio Suite Preview button (the tiny speaker at the
bottom left) to audition the Guide and aligned Output together. Use the three

colour- coded Solo buttons above to hear any combination of the input and

output signals.

Output

Ready

-« % BYPASS 0.0

preview Preview Processing

3. You can also adjust the Max Difference controls in the Match Timing and Match
Pitch sections to tighten or loosen the timing and pitch alignment applied by the
preset. With each change, the Output is reprocessed and the Output waveform
redrawn, and you can listen to it using the Preview button or click Render to

return it to the Pro Tools session, as described above.
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L

0:00:30.651
T B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

©

LOOSE TIGHT
33ms

B SmartAlign

B FORMANT SHIFT

E¥ TIP: To store your control changes to use again, click the Preset dropdown menu
and save them as a User Preset. Give them a name that tells you what is special
about it.

Other ways to Render the Output

NOTE: You can transfer the Output from VocAlign Ultra to replace the original Dub (as
we did above) or transfer it onto any other track in Pro Tools by selecting a time range
larger than a single sample anywhere on the target track and clicking the Render
button. Or you can change the Audio Suite Track selection button (bottom right of

picture "no track selected") to chose a Target track to render to.
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Selection Preset
VecAlign Ultra playlist USE IN PLAYLIST <factory default>

create continuous file antire salaction -+ BF COMPARE

mult-input mode ne track selected

A CAUTION: Be sure to make the correct target track selection before hitting
the Render button. Otherwise, it's likely that you'll still have a range selected on
the Dub source track, which will be overwritten when the Render is performed.

Process 'Female Dub GE'

Now we will process the Female Dub. This is the same pitch as the Guide, so use the
Vocal - Double - Slightly Loose Timing & Pitch setting again, or try any others in the

Vocal preset group.

Let's make sure you see all the controls this time. Press the Basic button to switch to
show the full Advanced controls. These are explained in detail in the Using VocAlign

Ultra section of this VocAlign Ultra User Guide.
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Advanced {:}

B MATCH TIMING B MATCH PITCH

Max Difference Max Difference Pitch Target

e. . ®

LOOSE TIGHT LOOSE TIGHT DUB GUIDE
33 ms 20 % 1000 %

Alignment Rule Algorithm Target Mode

Normal Flexibility Mode 1 Nearest Octave v

. Transpose
B SmartAlign

Max Shift No Limit ¥
HIGHER

00
@ High Resolution

B FORMANT SHIFT PITCH RANGES

Guide Normal

Dub Normal

Select the clip 'Female Dub GE' and press Dub Capture;.

Then repeat the auditioning process described above or render the Output back to

Pro Tools to hear it.

Bl If you are using the Pro Tools Preview to audition the output of VocAlign Ultra,
and you change any controls while playing, you will either need to stop and
restart the preview to hear the effect of the new settings- or if it has looped back,
you must wait till it restarts the loop to hear the new settings.
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Examine the Pitch

Now let's look at the Pitch Profile display. Press the keyboard switch at the bottom left

corner of the VocAlign Ultra interface.

VQCAlign ULTRA Vocal - Double - Slightly Loose Timing & Pitch

0:00:22.500

o .

OUTPUT ©

Ready

o
‘
o
o
]
o
L |
o
q
o
o
]
o
o
o
n
o
”.-

‘x

L}

Then, activate and deactivate the 'eye' buttons to see the Guide and Dub Pitch
traces, then the Guide and Output Pitch. Turn the Match Timing and Match Pitch Max
Difference controls and observe the effects of tighter and looser settings on the

traces.

Also, notice the white and gray patches along the bottom of the Pitch display. These
show you the relative amount of processing being applied to the Dub at every pointin
time. Tighter settings will usually require more processing (whiter shading). Turn on
the Dub pitch trace to see how different it is from the Output pitch and/or timing.

Where there are big differences, the processing strength will be white.
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The Formant Shift function can be used to add some character to the Output. Try

lowering or raising it on the female voice.

Finally, when you like the sound of your Output, render the processed track back to

the 'Female Dub GE Track' and listen to it with the Guide and other processed tracks.

Processing a Harmony Track

There are two Harmony tracks in this session: Male Harmony and Female Harmony.

e Harmonies are actually slightly easier to process, because you don't want

to align their pitch to the Guide.
e Because of this, the Harmony presets only process timing.

e However, that does mean at least one of your harmony parts must be in tune. If
you have doubles of that harmony, you can of course apply the timing and pitch
of its Output to those doubles to match the new time aligned harmony with

correct pitch.
Select the Preset Vocal - Harmony - Tight Timing
Select and Capture one of the Harmony Tracks.
Return it to Pro Tools.

Finally, do the same to the last harmony.

Audition the end result
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If you have time aligned all the tracks to the Guide, and returned them over the
original tracks, you can play them all together to hear the vast differerence you will

have made with VocAlign Ultra in a very short time.

CONGRATULATIONS!!
Fixing problems

Protected Areas

There will be times when you want to exclude certain sections in the Dub from
processing - when your Guide vocal jumps up an octave, or gets raspy and lower, but
your Dub doesn't, for example. Or when there are different words or syllables in the
Guide and Dub, which can throw the time alignment off, resulting in unnatural
distortion of the Output timing. VocAlign Ultra's Protected Areas enable pitch, time or
both to be kept unprocessed over any specified range within the Dub. We'll
demonstrate this using the 'Tiny Heart' Pro Tools session - please download and open

it.

1. Follow the procedure described above to open VocAlign Ultra Audio Suite plug-
inin Pro Tools. Before we process anything, listen to Tracks 2 and 3 from bars
27-35. You might want to raise the level of this track 3 to 4 dB to hear time and

pitch issues in the high voice against the lead vocal.

2. Now select in Pro Tools the Lead Vocal audio event and Capture it as the guide.
If you are not using SmartAlign, highlight the track from bars 27-35 and Capture

that as the Guide.

3. Next select the preset: Vocal - Double - Slightly Loose Timing & Pitch.
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4. Lastly, select the Lead Vox High Chorus audio event and Capture that as the

Dub. If you are not using SmartAlign, highlight bars 27-35 of the Lead Vox High

Chorus audio event and Capture that as the dub.

23 25 27 29 31 33 35 37 39 v
(0:45:00 00:00:50:00 00:00:55:00 00:01:00:00 00:01:05:00 00:01:10:00 00:%:15:00 00:01:20:00 00:01:
+
+

L~ INSERTSAE  SENDSA-E 1o Ll b b b b b b b b b e b b b b b b b b b b b e o b o b b b b b e b o L L

vol 0.0

‘ ‘ l Lead vox High CI

]
Selection Preset ©
VocAlign Ultra playlist "USEINPLAYLIST <factory default>
create continuous file entire selection -+ & COMPARE

multi-input mode no track selected

= Voc/.\lig N ULTRA  Vocal - Double - Slightly Loose Timing & Pitch Basic £ ?

0:01:90.000 0:01:05.000 0:01:10.000 0:01:15.000
) B MATCH TIMING B MATCH PITCH

Max Difference Max Difference

LOOSE TIGHT LOOSE® TIGHT

DUB

+
) B SmartAlign
-

B FORMANT SHIFT

OUTPUT

Render 5 R R o | S e

Ready

LU U W =

5. Render the Output back to the same Pro Tools track and listen to this selection
in tracks 2 and 3. You can hear the time and pitch are closer. But if you listen to
the Output Dub on its own, you can clearly hear the pitch of the Dub going awry
on the word "again" at the end of the phrase, as it aligns the Dub with the

raspy pitch drop in the Guide.

We can fix this by creating a Protected Area within the Dub - a range that maintains

the original Dub'’s pitch, timing or both.
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For a visualisation of the signals' pitches, switch to the Pitch Profile View by clicking the

keyboard button n below the main display, and zoom in on the very end of the Dub.

Use the vertical slider at the right of the display and the Scale control above
it. You'll see the Guide (blue) pitch shows an octave drop when it gets ‘creaky’, which is
transferred to the Dub and affects its pitch quality in the Output signal (the yellow

trace).

Toggle the Match Pitch button off and on and you'll see the last section of the Output

jump between the natural pitch of the Dub and the incorrectly aligned pitch.

VocAlig N ULTRA Vocal - Double - Slightly Loose Timing & Pitch

0:01:13.000 0:01:13.500 0:01:14.000
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OUTPUT ©

Ready
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6. Switch back to the Waveform view by clicking the waveform button next to

the Pitch Profile keyboard button.

7. Ifyou are in the Basic control display, click the Basic Control display button to
switch to Advanced mode, then click the dividing bar labelled Protected
Areas (if none have been created) between the Dub and Output waveforms at

the start of the unwanted pitch drop to create a new Protected Area.
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0:01:13.500 0:01:14.000

Sync Points
DUB

OUTPUT i o
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e nTet B W £ B

Ready

W W =

8. Drag the ‘shield handle at the right hand end of the Protected
Area to encompass the last ‘piece’ of the Dub waveform, then right-click in the
Protected Area and select Modify Protected Area > Protect Pitch - now

the timing will be aligned but the pitch won't.

You can see this by going back to the Pitch Display and look at the yellow Output Pitch,
now overlapping the red Dub pitch exactly because it is now protected from pitch

changes (but not time changes).

As an exercise, work back through the Dub, adding further Protected Areas where

required.
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Voc/\llg N ULTRA  Vocal - Double - Slightly Loose Timing & Pitch
0:01:13.500 0:01:14.000

Sync Points
DUB

Modify Protected Area Protect Pitch and Timing

Delete Protected Area Protect Timing
Automatic Sync Points v Protect Pitch
OUTPUT Add Sync Point

[N
EEZED oy

v

Ready
i) oy (17]

Sync Points

If you're getting small differences in timing caused by different words, sounds or
delivery, you can correct them using Sync Points. These let you assign pairs of pointers
to events in the Guide and Dub that should be time aligned if they are not. One of the
pair is moved to a position in the Dub waveform and the other paired pointer is
moved the a similar position in the Guide waveform, and the alignment engine does
it's best to nudge the two points together, assuming the audio around that point in the
Dub is amenable to being compressed or stretched by the required amount. Click here

for more details on Sync Points and how to use them.

And finally...
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There's always more to learn, so head to the sections of the full User Guide at the left

in the Using VocAlign Ultra folder, for much more information on VocAlign Ultra's
controls and displays, and for the latest videos and tips, click this link: VocAlign Ultra

with Pro Tools .

123


https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra
https://www.synchroarts.com/compatibility/editor-product/Pro_Tools/VocAlign_Ultra

VocAlign Ultra User Guide V1.1
7.2. VocAlign Ultra Quick-Start Guide for Logic Pro X

e Quick Start for Logic Pro X and DAWSs using AU Plug-ins

e Two Plug-in Versions

e Installation and Initial Setup

e Using the ARA version of VocAlign Ultra

e Using the real-time AU version of VocAlign Ultra in Logic Pro X

e More details on saving my output audio

Quick Start for Logic Pro X and DAWSs using AU
Plug-ins

Overview

In this Quick Start Guide you will learn how to set up Logic Pro X and VocAlign Ultra to
transfer audio into VocAlign Ultra, process the audio, and have the processed output

returned to Logic Pro. Other DAWSs using AU plug-ins should have similar workflows.

A Ableton Live users: Do NOT use the AU version of VocAlign Ultra, use the VST3
Real-Time Capture Version. Click here to go to instructions.

The procedure might seem a little complex at first because you have to tell the plug-in

which track contains the Guide and which track(s) need their timing and/or pitch

adjusted by VocAlign Ultra to match the Guide's.

In this Quick Start Guide, we won't go into details about the control panels or displays,

since those are described in the "Using VocAlign Ultra" sections.
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One last note - because we started long ago in the film industry, we call the audio to

be modified a “Dub”.

Two Plug-in Versions

VocAlign Ultra installs two versions of the Audio Unit (AU) plugin used by Logic Pro X
(and some other DAWSs):

e VocAlign Ultra AU (ARA) - which only runs in Logic Pro X 10.5.1 or later.

e VocAlign Ultra AU (Real-time capture) - which runs in Logic Pro 10.0.0 and

later.

These plug-ins both feature the same processing controls, presets and parameters,

and are identical in terms of the end results they deliver.

The versions only differ in the way audio signals are brought into VocAlign Ultra and

how the Output is returned to the DAW.

e The AU (ARA) plug-in is applied to the track and the user “Captures” the digital

audio directly as the designated Guide or Dub in an instant transfer process.

o The main advantages of this approach are that the capture is faster and

you can bounce the processed audio to disc.

o The main disadvantage is that in Logic Pro you must press the space bar

regularly to update the ARA audio data base.
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o It'simportant to understand that the ARA version loads as a single

'extension' in Logic Pro, and although it might appear that you're adding
the plugin to each discrete region being processed, you are in fact

adding those regions to the same single instance of VocAlign Ultra ARA.
e The AU (Real-time capture) plug-in version is also a track insert plug-in and involves

making a real-time playback to capture both the Guide (as a side chain input) and the

Dub simultaneously.

o The main advantage of this approach is that you can start and stop the capture

of the Guide and Dub at any points in your session.

o The main disadvantage is that if you export the Output to replace the input Dub
it removes the plug in, and there is no undo to restore the plugin to modify the

processing.

Installation and Initial Setup

e You should have already downloaded, installed and authorised the VocAlign
Ultra plug-in on your Mac computer.

See Installation and Authorization if you haven't done this.

e Download the Logic Pro ‘Tiny Tiny Heart’ session from Tiny Heart Logic Session

and follow along with the operational instructions below.

e It's also necessary to make Logic's track selection automatically follow the

selection of audio regions.

o This may already be set up, but if not, in Logic Pro, open Preferences >

General, and select the Editing tab at the top.
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o Inthe Editing page, enable ‘Select tracks on Region/Marquee

selection’.

Using the ARA version of VocAlign Ultra

ﬂ THE FOLLOWING ARA INSTRUCTIONS ARE ONLY FOR: Logic Pro X
10.5.1 and later.

NOTE: The AU (ARA) version only works with recent versions of Logic Pro and operates differently
than the AU Real-time capture version.

You can skip the ARA instructions and click HERE to jump to AU Real-Time Capture instructions for
Logic Pro 10.0.0 and above.

A FOR LOGIC PRO 10.5.1 Users

Once you've installed VocAlign Ultra, you'll need to perform these “one-time”
additional steps in Logic Pro to be able to use the ARA version:

1. Launch Logic Pro X and open any project or create an empty project.

2. Add VocAlign Ultra AU as an insert effect to any track in the project.

3. Quit Logic Pro X without saving.

4. The next time you run Logic Pro X, VocAlign Ultra (ARA) should appear in

Logic’s Plug-in Manager and Audio FX menus under ‘Synchro Arts’

Note - this issue is fixed in Logic Pro 10.6.1 and above.
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A If you're using an Apple Silicon Mac, rather than an Intel-powered model, you'll currently need to

switch Logic to Rosetta Mode to use the VocAlign Ultra AU (ARA) plugin. To do this, right-click the
Logic Pro application in your Mac's Applications folder, select Get Info, and check the ‘Open using
Rosetta’ checkbox.

IMPORTANT OPERATIONAL NOTE FOR USING LOGIC PRO WITH ARA
PLUG-INS

e As of VocAlign 1.1, VocAlign will quickly start and stop playback each time
the Capture button is pressed, before initiating the capture of audio. This

will create a short burst of playback.

e This ensures that VocAlign Ultra AU (ARA) (and all other ARA plugins) are

updated correctly.
e Thisis a requirement of Logic Pro rather than a design decision of Synchro Arts.

e If needed, you can manually update all ARA plugins by simply tapping the
Spacebar twice to start and stop playback before you press either Capture

button in VocAlign Ultra.

Let's Start Processing

[Updated video for VocAlign 1.1 in Logic Pro with SmartAlign workflow forthcoming]

Note: we recommend using the SmartAlign workflow as your default workflow. The

'SmartAlign disabled' workflow is provided in case of any issues.
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1. Load the Tiny Heart’ project in Logic.

2. Add VocAlign Ultra AU (ARA) as an insert effect on the Lead Vocal Track - which
we'll be using as our Guide - by selecting Audio FX > Audio Units > Synchro

Arts > VocAlign Ultra AU (ARA).
3. Start and stop playback in Logic Pro using the Spacebar or transport buttons.

4. In VocAlign Ultra, select the preset: Vocal > Double > Slightly Loose Timing &

Pitch, if it isn't already selected.

You should see a screen similar to the image below.

9

M S R  Tiny Heart Track Tiny Heart Track Q@D
Lead Vocal O

Lead Vocal

M S [ ) \ 4 He AP

Lead Vocal
Side Chain: = None

Copy  Paste Undo Redo View: | Editor o

VOCAIign ULTRA Vocal - Double - Slightly Loose Timing & Pitch Basic
0:01:10.000 0:01:12.0[0 0:01:14.000

Guide: This track will contain|the audio you are matching.

7
Dub: This track will contain the audio that will be modified
to match the audio in the Gujde track above.

Lead Vox High Chd

e
‘ M S R OUTPUT ‘:

the modified Dub audio.
nore instructions.

Output: This track will contaii
No Output Press the help "?" button for
Male Vocal 1 W =

um‘\m
M S R

Male Vocal 2

e
v ‘ M S R

Chorus Lead Dub left

um‘m»
M S R

[ )
@

Chorus Lead Dub R Chorus Lead Dub Chorus Lead Dub RIGI
\M\M\ Chorus lead dub Right

M S R [ ]

&

Ed TIP: You can scale VocAlign Ultra to almost any size to see the Logic Pro window
better, by dragging the striped triangle in the bottom right corner of the plug-in
window.
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5. When VocAlign Ultra AU (ARA) loads, click the Link (chain) button at the top right
of the plugin to turn it ON - and the background will turn purple as shown

below.

Side Chain:

View:

Basic

We want to align the out-of-time Lead Vox High Chorus double track with Lead Vocal,

so Lead Vox High Chorus is our Dub.

6. Add VocAlign Ultra AU (ARA) as an Insert on Lead Vox High Chorus, as

described in step 2

7. Follow the step below depending on your settings:

Smart
Align Select the Lead Vocal audio region.
enabl
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ed M S R  Tinv Heart Track Tiny Heart Track QD

(defa Lead Vocal O
It i Lead Vocal

uft) M S

Solo the Lead Vocal and Lead Vox High Chorus tracks and set Logic's Cycle
range from bar 27 to 35 to loop the section you'll be working on.

Split the Lead Vocal region at bars 27 and 35, and the Lead Vox High
Chorus region at bar 27 to isolate the required sections.

S R | Tinv Heart Track

Lead Vocal
MI§ R I

M SR I BN

M S R | BV2 L
Lodavoxvignohowiz 0
Lead Vox High Chorus

M (S N @) \_4 ekt B S et L LR L

Male y-—"*
M S

Male y

M S VocAlign uLtrA

Select the isolated Lead Vocal region.

8. InVocAlign Ultra AU (ARA), press the Guide Capture button. VocAlign will
quickly start and stop playback and you'll hear a short burst of playback.

The Guide audio waveform will appear in the Guide section and an outline of the

Guide will also appear in the Output section to act as a timing reference for the

processed Dub.
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imy Heart Tuned Lead Wocal(3)

Dub: This track will contain the audio that will b dified
to match the audio in the Guide track above.

OQUTPUT

Mo Output

9. In Logic, select the corresponding audio region on the Lead Vox High Chorus

Track.
Note: If SmartAlign is disabled, select the region you cut from bars 27 to 35.
2. Press the Dub Capture button.

The Dub waveform appears in orange in the Dub section. At the same time,
VocAlign Ultra AU (ARA) will align the Dub to the Guide and create the aligned

Output, represented by the yellow waveform in the Output section.

11.Start playback in Logic Pro to hear the Lead Vox High Chorus track play the
perfectly aligned Output signal from VocAlign Ultra. Note in the picture below,
the yellow Output (processed Dub) audio is shown visually matching the Guide
waveform outline - but not perfectly - because you've chosen "Slightly Loose

Timing".
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0:00:50.000 0:01:40.000
iny Heart Tuned Lead Vocal(3)-24b.wav

DUB ead vox High Chorus-24b.wav

OUTPUT

e B R & 9 o e

Changing tightness setting

If you want to hear what turning the Max Difference control in the Match Timing
section, turn it towards or to 0 or away and listen to the difference as well as see the

difference in the Output time display.

El NOTE: We've only capturing a single Dub here, but with ARA you can capture
multiple stacked Dubs at the same time which will initially be processed by the
same Preset. This will be detailed in the main User Guide.

Correcting areas where Guide Pitch is uncertain or too different

from Dub pitch

Because we have chosen a real Guide input that has "typical" uncertain pitch in a few

places (because of vocal "creaks" at the end of some phrases), VocAlign Ultra
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will make the Dub try to match these areas containing a range of Guide pitches that
are sometimes an octave lower when it is measured compared to what we hear. This

sort of mis-measurement will affect the Output at these points.

We can fix these by creating Protected Pitch Areas within the Dub. These are areas

that maintain the original Dub's pitch, timing or both.

This is a useful technique to learn for situations when there are different words or

sounds in the Guide and Dub at certain points and make them sound unnatural.

In the above example, you might have noticed a "squeak" in the Output at the very
end of the signal where the Guide singer's voice "creaks" and the original Dub has a

high note that gets the wrong pitch applied to it at the very end of the phrase.

For a visualisation of the signals' pitch, switch to the Pitch Display by clicking the pitch

display selector,

- shown left which is below the left side of the main display.

Now zoom in on the very end of the Dub. Use the slider at the right of the display and
the "scale" controls to see the entire range. You'll see the Guide (blue) pitch shows an
octave drop when it gets "creaky". This affects the pitch quality in the Output signal
(the yellow trace). Toggle the Match Pitch button off and on and the last section of the
Output will jump between the input pitch of the Dub (red) and the incorrectly aligned

pitch.
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Delete

Double-click in the Pitch display at the start of the Guide pitch drop (as shown above)

to set the playback head at that point.

Then switch back to the Waveform view by clicking the waveform display button

- to the left of the Pitch Display button.

Click the Basic Control Panel mode button to switch to Advanced mode.

Then Right click the dividing bar that says "Protected Areas" between the Dub and
Output waveforms at the playhead position. Holding down the mouse key you can

select "Add Protected Area" and "Protect Pitch".
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iry Heart Tuned, Lead Wochl{3)-2

Sync Points
Lefd wor High Chaorus 240, Wy

Protected Areas

Add Protected Area r Protect Pitch and Timing '
Automatic Sync Points Protect Timing
Proted:Pitch

OQUTPUT

Ready

When you release the click, you will see a Protected area as shown below with a Note

symbol indicating it is protecting pitch.

Tirw Heart Tuned,Lead Wockl[3)-2

Sync Points
Lead wox High Chorus-24b.y n

OUTPUT

Ready

(Note: If you had left clicked, you would have automatically added a Time and Pitch
Protected area starting where you clicked. You can right click a Protected Area to

change its settings.)

Drag the right ‘'shield’ handle of the Protected Area to move it to the end of the Dub

pitch trace as shown below.
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0:01:14.000

QUTPUT

Ready

If you now switch back to the Pitch display, as shown In the picture below, the Output
pitch (yellow) is now exactly on top of the original Dub pitch so the audio will be in

time and not corrupted by the Guide pitch issues.

e Heart Tuned Lead Wocall3)-2

OUTPUT ©

Ready

As an exercise, you can try this on other signals in this session where the Guide voice

becomes creaky.
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Matching the Timing of Harmonies to a Lead Vocal

Now let's align a harmony vocal with the following steps.

If you are going to use a different preset on a new Guide and Dub, if you
change the preset or ANY control before you capture the new Guide, it will
be applied to the current Dub, which you might not want to happen.

Here is the safest order in which to perform your operations:

1. Before you move on to capture a new Guide, don't change the
preset or any controls!!

2. Capture your new Guide

3. Change the preset or controls after the new Guide has been
captured (if you want to)

4. Capture the Dub (it will be automatically processed with the new
preset and control settings).

1. Load VocAlign Ultra AU (ARA) onto the BV2 track.

2. If SmartAlign is disabled or you've selected a SmartAlign OFF preset, set Logic's
Cycle markers to cover bars 47 and 56 and then split the Lead Vocal track at the

resulting region.

3. Capture the Lead Vocal region as the Guide and the BV2 region as the Dub.
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Delete

4. Click the Preset menu and load the Vocal > Harmony > Tight Timing preset.”

This will tightly match the BV2 region’s timing - but not pitch - to that of the Lead

Vocal region.

0:01:40.000 0:01:45.000 0:01:50.000
iny Heart Tuned|lead

QUTPUT

El REMINDER: If you want to change a Preset or Control to process the next
Dub, change it AFTER YOU CAPTURE YOUR NEXT GUIDE !!

Processing audio along the timeline or down the tracks
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You can continue to copy sections along a track and keep the same settings, or even
capture Dubs sourced from two different tracks, with each Dub Capture setto a
different preset. Switch between them for editing by clicking them in the main display
or Overview, or by selecting their source regions in Logic Pro itself. The selected area

will be coloured in, while all unselected areas will be greyed out.

0:00:50.000
Tuned Lead Vocal(3)-24b.w@v

- 2(3)-24b.wav

To export the Output from VocAlign Ultra AU (ARA) to a track, select a Dub region in
Logic Pro, start and stop playback, then go to the File menu or right-click the region
and select Bounce > Regions in Place... (key command: Ctrl+B). Adjust the various
options presented in the Bounce dialog, as required - replace the region on the track

or bounce to a new track, mute the original track, etc.
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Processing a "Stack"” of Dubs at the Same Time

If you have several Dubs that all have similar audio (i.e. either Doubles or Harmonies -
but not both at the same time), you can select the Dub events and process them at the
same time with the same settings. However, you will have to change the process
setting for them individually after that, by selecting either the Dub in your DAW or
right clicking in the VocAlign Ultra Dub window and selecting the Dub you wish to

modify, one at a time.

Alternatively, you can use the Delete command to remove the Dubs and their Guide
from VocAlign Ultra and then recapture them with a different setting, which the

Dubs will all received at the same time and create new Outputs with the new setting.
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THIS IS THE END OF INSTRUCTIONS FOR ARA MODE

Using the real-time AU version of VocAlign Ultra in
Logic Pro X

The ‘regular’ AU (Audio Units) version of VocAlign Ultra captures the Guide and Dub in
real time in two specified tracks, but only requires one instance of the plugin to be
loaded on the Dub track, and the Guide is captured at the same time via the plug-ins

Side Chain input.

This might seem strange, but it is the Dub track that is being processed and the

processed audio is returned to the Dub track when the processing is finished.
Let's process some tracks

1. With the Tiny Heart’ project loaded in Logic, add VocAlign Ultra AU as an
Insert effect on the Lead Vox High Chorus Track by selecting Audio FX >
Audio Units > Synchro Arts > VocAlign Ultra AU as shown below. This will be

our Dub, to be aligned with the Guide.
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Guide: This track will contain the audio you are matching.

Dub: This track will contain the audio that will be modified
to match the audio in the Guide track above.

OUTPUT
Output:|This track will contain the modified Dub audio.

No Output Press the help "?" button for more instructions

1w

Delete

Lead Vox...h Chorus Stereo Out

2. Atthe top right of the VocAlign Ultra window set the Side Chain input selector

as shown below (with the word "None") to the Lead Vocal track, which we'll use

as our Guide.
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bh Chorus

Side Chain|  None

Tiny Heart Track (Audio 1) Audio
Lead Vocal (Audio 3) Input
Chorus Lead Dub left (Audio 5) N
Chorus lead dub Right (Audio 6)

Chorus dub high left (Audio 7)

Chorus Dub High Right (Audio 8)

BV1 (Audio 9)

BV2 (Audio 10)

Male Vocal 1 (Audio 11)

Male Vocal 2 (Audio 12)

Also at the top right of the plug-in window click the Link (Chain) to ON which will have
a purple background. This means you only will get one VocAlign Ultra window, even

though you may have created several instances.
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Side Chain: None

View: Editor

Basic {:}

3. NOTE: If you don't see the Sidechain control, click the gray button at the top

right corner of the plug-in as shown below:

4. Solo the Lead Vox High Chorus and Lead Vocal tracks if you want to hear them

as you capture them.

Set Logic's Cycle range from bar 27-35, to isolate the required section so you can

check it after processing.
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Lead Vocal O

Lead Vox High Chorus_1 O
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5. Select a Preset. For this case, Vocal > Double > Slightly Loose Timing &

Pitch .

6. Click the Capture button in VocAlign Ultra and start playback of the Guide and
Dub in Logic Pro - the button will change to Stop and capture will begin. The

red lights in the Guide and Dub track will flash to show capturing is taking place.
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OUTPUT

No Output Output: This tradk will contain the modified Dub

Press the help "?

7. Press stop in Logic (or the Stop button in VocAlign Ultra) at the end of the
range. The captured audio waveforms will appear in the Guide and Dub

sections of the display, and the aligned Dub will appear in the Output section.
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VocAlign Ultra AU

Correcting areas where the Guide Pitch is uncertain or too different

from the Dub's

There are a few points in the Output where the differences in pitch movement
between the Guide and Dub result in over-alignment of the Dub. We can fix these by
creating Protected Areas within the Dub - areas that are ‘immune’ to changes in
pitch, time or both. The most obvious anomaly happens with the word “again” at the

very end of the phrase.

1. For avisualisation of this, switch to the Pitch Profile View by clicking the
keyboard button below the main display, and zoom in on the very end of the
Dub. You'll see a big, unnatural pitch drop in the Output signal (the yellow trace).
To see what processing was done, you can toggle the Match Pitch button off
and on and the last section of the Output will jump between the natural pitch of

the Dub and the incorrectly aligned pitch.
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2. Switch back to the Waveform view by clicking the waveform button next to the
Pitch Profile keyboard button. Click the Basic edit mode button to switch to
Advanced mode, then click the dividing bar between the Dub and Output
waveforms at the start of the unnatural pitch drop to create a new Protected

Area.
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0:01:13.000 0:01:13.500 0:01:14.000

Sync Points

3. Drag the 'shield’ handle at the right hand end of the Protected Area to
encompass the last ‘piece’ of the Dub waveform, then right-click in the Protected
Area and select Modify Protected Area > Protect Pitch - now the timing will
be aligned but the pitch won't. As an exercise, work back through the Dub,

adding further Protected Areas where required.
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Matching the Timing of a Harmony to a Lead Voice

Now let's align a harmony vocal. In this case, we don't want to match its pitch to the

Guide, so it needs to be reasonably in tune.
1. Load VocAlign Ultra onto the BV2 track (the Dub), then set Logic’s Cycle markers
to 47 and 56.

2. Select the Preset: Vocal - Harmony- Tight Timing to tightly match lock

the BV2 region’s timing - but not pitch - to that of the Lead Vocal region.

3. Set the Sidechain input in the new instance of VocAlign Ultra to the Lead Vocal

track again (the Guide. Press Capture and the screen should look as below.
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OUTPUT
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4. Start Playback in Logic and then press stop playback in Logic, or the Stop button

in VocAlign Ultra at the end of the section.

ULTRA Viocal - Harmony - Tight Timing

0:01:45.000

Sync Points

Protected Areas
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5. To review what you've done, click in the VocAlign Ultra overview or main display
- or select the relevant regions in Logic Pro - to switch between the three
captures. You'll see the controls in VocAlign Ultra update accordingly. Note that
you can add further Captures to any instance of VocAlign Ultra by simply
repeating the Capture process at a different point on the timeline, using the
same or a different Sidechain input as the Guide. You'll then be able to apply
different Presets and settings to each Capture, if required, by clicking any one to

select it, then making your changes.

Lead Vox High Chorus Lead Vox High Chorus1 O Lead Vox High Cho

Q) Side Chain: | Audio 3

< D> Compare Copy Paste Undo Redo View:  Editor ¢

VoCAIign ULTRA Vocal - Harmony - Tight Timing v Basic Q‘

0:00:50.000 0:01:40{000 0:02:30.900
T B MATCH TIMING B MATCH PITCH

Max Difference ‘

-

Oms

B  SmartAlign

T B FORMANT SHIFT
o=

6. To export the Output from VocAlign Ultra AU (ARA) to a track, select a Dub
region in Logic Pro, then go to the File menu or right-click the region and
select Bounce > Regions in Place... (key command: Ctrl+B). Adjust the various
options presented in the Bounce dialog, as required - replace the region on the

track or bounce to a new track, mute the original track, etc.

More about Bouncing
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Note that the Real-time Capture version (non-ARA) cannot reconnect the rendered audio back to
VocAlign Ultra.

More details on saving my output audio

For a complete explanation of the options for saving VocAlign Ultra's output audio

read this chapter.
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7.3. VocAlign Ultra QuickStart for DAWs using VST3
plugins

e Quick Start for VST3-compatible DAWSs

e Overview

e Installation and Initial Setup

e Two Versions of VocAlign Ultra VST

e Using the VST3 ARA version of VocAlign Ultra

e Using the real-time VST3 version of VocAlign Ultra

e More details on saving my output audio

Quick Start for VST3-compatible DAWSs

Studio One, Cubase, Nuendo, Ableton Live, Reaper, Cakewalk

For OTHER DAWS you can check here for an up-to-date list of DAWs compatible with
VocAlign Ultra

Overview

155


https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra
https://www.synchroarts.com/compatibility/editors/VocAlign+Ultra

VocAlign Ultra User Guide V1.1

In this Quick Start Guide, you will learn how to set up your VST3-compatible

DAW and the VocAlign Ultra plug-in to be able to load audio into VocAlign Ultra,

process it, and return the processed output to your DAW.

What about my DAW?

We will show how this VocAlign Ultra works using Studio One as an example.

However, very similar procedures apply to Cubase, Nuendo, Live and many other

DAWS using VST3.

Ed IMPORTANT: Whenever there is a difference in operations from Studio One and
the other DAWs listed, we will provide links to EACH DAW's specific
instructions for you to follow, after which, you will be returned to this main
section to continue to follow the instructions in Studio one, but common to all
DAWSs mentioned.

If you are new to our products, the audio transfer procedures might seem more

complex at first than other plug-ins.

This is because you have to tell VocAlign Ultra which track is the Guide and which
track(s) are the ones that need their timing and/or pitch adjusted by VocAlign Ultra to

match the Guide's.

We won't go into details in this Quick Start about the control panels or displays, as

those will be described in detail in the sections in the folder Using VocAlign Ultra.

One last note - because we started long ago in the film industry, we call audio to be

modified and output the “Dub”.

156



VocAlign Ultra User Guide V1.1

Installation and Initial Setup

To continue, you will need to have downloaded, installed and authorised
the VocAlign Ultra plug-in on your computer.

If you haven't done all of these, go to Installation and Authorization for
instructions.

Ready to go? Let's get a sample session to work with.

Click the Download link below for your DAW:

« STUDIO ONE - Download Song
« CUBASE / NUENDO - Download Session

e LIVE - Download Session

and then load the Session/Song into your DAW.

Two Versions of VocAlign Ultra VST

VocAlign Ultra loads as a VST3 plugin in Studio One, Cubase and other VST-compatible

DAWS.
Two different versions are loaded.
1. VocAlign Ultra VST3 (Real-time capture)

A This should run in most DAWS that support VST3 Side-chains.
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2. VocAlign Ultra VST3 (ARA)

This will only run in more recent VST3 DAWS which will be listed in
instructions below.

The two plugins both feature the same processing controls, presets and parameters,

and are identical in terms of the end results they deliver.

They differ only in the way audio signals are brought into VocAlign Ultra and how the
Output is returned to the DAW.

Remember, not all DAWSs support ARA, so you may only find the VST3 (Real-time

capture) version in yours.

e The VST3 (ARA) plug-in is applied in most VST3 DAWSs to
"events"/"Clips"/"Segments" etc. that you want to process in both Guide and
Dub tracks, and the user “Captures” the digital audio directly as the designated
Guide or Dub in an "instant transfer” process. However, in other DAWS, you will
apply itin a track.

e It'simportant to understand that the ARA version loads as a single 'extension'in
the host DAW, and although it might appear that you're adding the plugin to
each discrete event or region being processed, you are in fact adding those

events or regions to the same single instance of VocAlign Ultra ARA.
e We recommend using this approach if your DAW supports it.

e The main advantages of this approach are that the capture is faster than real-
time and you can bounce the processed audio to disc.
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e Adisadvantage is that the bypass function does not work in the ARA version, but

it works in the VST version.

e The VST3 (Real-time capture) plug-in version is a track insert plug-in and
involves making a real-time playback to capture both the Guide (as a side chain

input) and the Dub simultaneously.

e The main advantage of this approach is that you can start and stop the

capture of Guide and Dub at any points in your session.

e The main disadvantage is that if you export the Output to replace the input
Dub it removes the plug in and there is no undo to restore the plugin to

modify the processing.

For more detailed comparisons between these two approaches, go to this

section VocAlign Ultra Plug-in Versions and DAWSs.

If your DAW only supports the VST Real-Time Capture click Using the VST3 Real-

time version of VocAlign Ultra

Using the VST3 ARA version of VocAlign Ultra

[Updated video for VocAlign 1.1 in Studio One with SmartAlign workflow forthcoming]
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This section explains how to use VocAlign Ultra as an ARA plug-in with audio editors

that support ARA.

Because ARA is relatively new, sometimes only newer versions of DAWSs will support
this method. Your DAW instructions will probably make it clear that yours has this

feature.

For most audio editors such as Studio One or Cubase Pro, VocAlign Ultra needs to be
added to each clip of audio (Audio Event) as an effect (Event Fx), whereas others such

as Reaper, VocAlign Ultra can also be added as a track effect (Fx).

El The steps below describe how to use VocAlign Ultra as an ARA plugin in Studio
One.

The steps for using VocAlign Ultra with the other DAWSs are identical, apart from
Step 2, which describes how to add VocAlign Ultra to an Audio Event in Studio
One (i.e. aregion, clip, segment of audio in other DAWSs.

Define the audio to process

To follow these instructions, make sure you have downloaded and opened the session

for your DAW described above if listed.

1. We want to align the out-of-time Lead Vox High Chorus double
track with Lead Vocal, so Lead Vox High Chorus is our Dub and Lead Vocal is our
Guide. First, we need to load VocAlign Ultra ARA. Here, we'll show you how to do that

in Studio One, but to learn how to add VocAlign Ultra VST ARA plug-in to
e Cubase/Nuendo - click here

2. In Studio One, VocAlign Ultra is added to Audio Events as an Event FX.
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Q If Studio One Professional 5 does not show the Edit with VocAlign command in
the Audio menu after installing VocAlign Ultra, please update to Studio One
version 5.1.2.62686. The Edit with VocALign command will appear in
the Audio menu and VocALign Ultra will respond to it.

In Studio One Professional 4, you can still use VocAlign Ultra as an ARA plug-
in: hold down the Option key on your computer keyboard and drag the VocAlign
Ultra VST plug-in from the Effects Browser onto all the selected Audio Events you

want to process - Guides and Dub(s).

Select the Guide (Lead Vocal) and Dub (Lead Vox High Chorus) Audio Events in

Studio One.

Then, depending on what version of Studio One you have, from Studio
One's Audio menu, select Edit with VocAlign, or drag the VocAlign Ultra VST plugin

onto any selected Audio Event from the Browser while holding down the Option key.

This will add VocAlign Ultra to both selected Audio Events, and selecting either of those

Audio Events will open the VocAlign Ultra interface in the Studio One Edit panel.
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Tiny Heart Tuned Lead Vocal(3)-24b ead vox High Chorus(3) Lead vox High Chorus(2)
File Tempo 110.00 Speedup 1.00
Transpose 0 Tune 0

Bend Marker Threshold Audio Processing Audio Bend

Gain Envelope 0> 4 Normalize Audio ~N P Detect Transients
Time Lock Edit Lock ({ Reverse Audio |x Remove Bend Markers
Cut 4 Strip Silence i Split at Bend Markers

Copy Edit with Melodyne Chords

Delete ¥ Remove Melodyne Detect Chords

Duplicate . Edit with VocALign Remove Chords

Recent items X Remove VocALign fF7 Extract to Chord Track

. Edit with VocALign Volume Envelope {7 Apply Chords from Chord Track

¢ Remove VocALign Fade In to Cursor |§ Extract Key Signatures from Event

) Toggle Mute N Fade Out from Cursor Audio Parts

[XJ Create Crossfades

¥ Select in Pool

Create Autofades @+ X % Merge to Audio Part

Create Crossfades X O%] Select in Pool

- Event Decrease Volume ~= 4 NumPad- @ New Clip Version
General operations for events
Audio

A Operations specific to audio events

+ Increase Volume ~= 4+ NumPad+ @ Send To new SampleOne
Reset Gain Envelope = Send To new Impact
m Instrument Parts <
Operations specific to instrument parts

Chorus dub high left_1(3)

2a. If you are not using SmartAlign, do the following before moving to

step 3:

e Solo the Lead Vocal and Lead Vox High Chorus Tracks if you like, and set your

DAW's Cycle range from bar 27-35 to loop the section you'll be working on.

e Split the Lead Vocal region at bars 27 and 35, and the Lead Vox

High Chorus region at bar 27 to isolate the required sections.

NOTE: We've only capturing a single Dub here, but with ARA you can capture
multiple stacked Dubs at the same time which will initially be processed by the
same Preset. This will be detailed in the main User Guide.
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How to Align a Double

(Remember, we're using Studio One as an example, but the steps taken to process the

Dub audio are now exactly the same in all other VST3 ARA plugin hosts.)

3. In VocAlign Ultra, select the Preset Vocal > Double > Slightly Loose Timing &

Pitch .
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111 9|1 1711 25|1 33|1 411

Guide: This track will contain the audio you are matching.

vue Dub: This tradk will contain the audio that will be modified

to match the jpudio in the Guide track above.

OUTPUT
Output: This track will contain the modified Dub audio.

No Output Press the helg "?" button for more instructions.

iy

Delete

TIP: If you want to change a Preset to process the next Dub, change it AFTERYOU CAPTURE THE NEXTGUIDE !!

4. Next, in your DAW, select the Guide audio - that's the Audio Event (Clip, Segment,

etc.) on the Lead Vocal track.

ﬂ If you are working with a preset that specifies SmartAlign OFF or you have disabled SmartAlign, the
Guide Audio Event (Clip, Segment) must match the start and end time of the Dub. We prepared this in
step 2a.

Then press the Guide Capture button.

The audio waveform will appear in the Guide section and an outline will appear in the

Output track for comparison with the Output, when it is created.
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to match the audio in the Guide track above.

OUTPUT
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5. Select the corresponding Audio Event on the Lead Vox High Chorus Track. The

press the Dub Capture button.

The Dub waveform appears in orange in the Dub section, and VocAlign Ultra
automatically processes the Dub to the Guide and creates the aligned Output,

represented by the yellow waveform in the Output section.

Start playback in your DAW to hear the Lead Vox High Chorus track play the aligned

Output signal from VocAlign Ultra.

Voc/\hg N ULTRA  Vocal - Double - Slightly Loose Timing & Pitch
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6. Because we've chosen an input with ‘typically’ uncertain pitch in a few places (ie,
vocal ‘creaks’ at the end of some phrases), when VocAlign Ultra makes the Dub match

these areas of ‘incorrect’ Guide pitch, it will affect the Output at these points.

We can fix these by creating Protected Areas within the Dub. These are areas that

maintain the original Dub’s pitch, timing or both.

The most audible anomaly in our example happens in the word “again” at the very end

of the phrase.

For a visualisation of the signals' pitches, switch to the Pitch Profile View by clicking the
keyboard button below the main display, and zoom in on the very end of the Dub. Use
the vertical slider at the right of the display and the Scale control above it. You'll see
the Guide (blue) pitch shows an octave drop when it gets ‘creaky’, which affects

the pitch quality in the Output signal (the yellow trace).

You can see the issue if you toggle the Match Pitch button off and on and the last
section of the Output will jump between the natural pitch of the Dub and the

incorrectly aligned pitch.
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7. Double-click in the Pitch Profile display at the start of the pitch drop to set the
playback head at that point, then switch back to the Waveform view by clicking the

waveform button next to the Pitch Profile keyboard button.

Click the Basic edit mode button to switch to Advanced mode, then click the dividing
bar between the Dub and Output waveforms at the playhead position to create a new

Protected Area.
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iy

Delete
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8. Drag the ‘shield’ handle at the right hand end of the Protected
Area to encompass the last ‘piece’ of the Dub waveform, then right-click in the
Protected Area and select Modify Protected Area > Protect Pitch - now the timing

will be aligned but the pitch won't.

As an exercise, work back through the Dub, adding further Protected Areas where

required.

168



VocAlign Ultra

Modify Protected Area Protect Pitch and Timing
Delete Protected Area Protect Timing
Automatic Sync Points v Protect Pitch

Add Sync Point

How To Align a Harmony

9. Now let’s align a harmony vocal. Select the BV2 audio event, and capture it as a new
Dub. Since the ARA version can work with multiple Dubs, we do not need to change

the guide.

ﬂ If you need to change which Dub region you are working with, select the audio event in your DAW, or
right click the dub waveform track and Select Audio as described in User Interface and Operation.

9a. If you are not using SmartAlign, do the following instead:

First, split the Lead Vocal and BV2 tracks at bars 47 and 56, and set your DAW's Cycle

markers to cover the resulting range.
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Example 2 OUT

iny [Heart Tuned Lead Vocal(3)-24b Tiny Heart Tuned Lu

Lead vox High Cho

Then select both Audio Events and add VocAlign Ultra as an Event FX on each, as

described in Step 2 above.

Then select the Lead Vocal event and Capture it as your guide. Continue to Step 10.

10. Click the Preset menu and load the Vocal > Harmony > Tight
Timing preset to lock the BV2 region’s timing, but not pitch, to that of the Lead
Vocal region. VocAlign Ultra automatically processes the Dub to the Guide and creates

the aligned Output, represented by the yellow waveform in the Output section.
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10a. If you are not using SmartAlign, do the following instead:

Click the Preset menu and load the Vocal > Harmony > Tight Timing preset to lock

the BV2 region’s timing, but not pitch, to that of the Lead Vocal region.

Now select the BV2 audio event and press the Dub Capture button. The Dub will be
captured and VocAlign will create the aligned Output, represented by the yellow

waveform in the Output section.

ULTRA Vocal - Harmony - Tight Timing

0:01:40.000 0:01:50.000 0:02:00.000
iny Heart Talped ldac ; B MATCH TIMI

Max Difference

r Heart Tuned Le’ad
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B
REMINDER: Do not change the Preset or ANY control before you've Captured a new Guide or you
will, in fact, be reprocessing the previous Dub audio.

Here is the safest order in which to perform your operations:

1. Before you move on to capture a new Guide, don't change the preset or any
control.

Capture your new Guide.

Change the preset or controls after the new Guide has been captured (if you want
to)

4. Capture the Dub (it will be automatically processed with the new preset and
control settings).

11. VocAlign Ultra now contains two separate Dubs sourced from two different tracks,

each set to a different preset.

Switch between them for editing by selecting them in the main display or Overview, or
by selecting their source regions in the host DAW's arrange page. You can also right-
click the waveform and highlight Select Audio. The selected area will be coloured in,

while all unselected areas will be greyed out.

High Chorus Double selected:
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If you are using the non-SmartAlign workflow, you will see a screen similar to this:
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12. To render the aligned audio permanently in Studio One, select the Dub audio
event, then press Render in the audio event's Event FX information panel. This is
normally visible at the bottom of the left side of Studio One’s main display, if the
Inspector is enabled in the View menu. The Render button becomes the Restore
button once rendering is complete: click Restore to undo the render and recall the

original audio Event, with VocAlign Ultra ARA in place.

Please see your DAW's manual for instructions on rendering ARA plugin outputs if

you're not using Studio one.
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El TIP: Unless you render the aligned audio, it will continue to be applied as a real-
time effect, until the effect is turned off. This means that you will continue to hear
it as it was originally aligned, even if you edit the original audio. To avoid any such
confusion, render the effect before changing any audio in Studio One and it will
then replay reliably. You can Restore the real-time effect after rendering in Studio
One if you change your mind.

Processing a "Stack"” of Dubs at the Same Time

If you have several Dubs that all have similar audio (i.e. either Doubles or Harmonies -
but not both at the same time), you can select the Dub events and process them at the
same time with the same settings. However, you will have to change the process
setting for them individually after that, by selecting either the Dub in your DAW or
right clicking in the VocAlign Ultra Dub window and selecting the Dub you wish to

modify, one at a time.

Alternatively, you can use the Delete command to remove the Dubs and their Guide
from VocAlign Ultra and then recapture them with a different setting, which the

Dubs will all received at the same time and create new Outputs with the new setting.
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END OF VST ARA INSTRUCTIONS

Using the real-time VST3 version of VocAlign Ultra

Although VocAlign Ultra can capture Audio Events almost instantly in ARA mode using
the Event FX method described above, it can also be operated in Basic VST mode. The
plugin is used as an Insert on the Dub track and the audio is captured in real time
while playing. This can allow for finer control over what's captured, as you can select

the exact start and end points required.
The steps below describe how to use VocAlign Ultra as a VST3 plugin in Studio One.

The steps for using VocAlign Ultra in the other DAWSs are identical, apart from Step 2,
which describes how to set up the sidechain input to VocAlign Ultra for capturing the

Guide. We will provide a DAW-based jump to the instructions for this step.

NOTE: If VocAlign Ultra does not appear in Ableton Live for Windows, Click
"Show More" below

You will need to set Custom folder path:
C:\Program Files\Common Files\VST3\VocAlignUltra.vst3
in the Live Preferences, as shown in this image
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VocALign Tutorial for Ableton Live 10 [VocALign Tutorial for Ableton Live 10] - Ableton Live 10 Suite — O X

File Edit Create View Options Help

1 Steve Guide

Preferences n

How To Align a Vocal Double

1. Add the VocAlign Ultra VST3 plugin as an Insert effect on the Lead Vox High Chorus

track using your DAW's usual plugin loading system.

In Studio One, you can drag it onto the track from the Effects Browser, or load it via

the Mixer. The Lead Vox High Chorus track will be our Dub.
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Select the Vocal > Double > Slightly Loose Timing & Pitch preset in VocAlign Ultra.

M S Lead Vox High Chorus vl

None v O
W None v
= Lead Vox High Chorus 1 v

v_1(3)
¥ + Lead Vox High Chorus - Inserts
7B O I*1  1-VocAlign Ultra VST v
o
B <» default Sidechain  ®
v o Auto: Off Copy
v

— VOCA"gn ULTRA Vocal - Double - Slightly Loose Timing & Pitch
Small

Channel Group

Ll I Tiny ..rack Main Outs Guide: This track will contain the
2 e~ Lead..ocal

udio you are matching.

—_— 0:01:40.000 0:02:30.000
:
None ar

.
° BV 1 M S Dub: This track will contain the a
o~ wv2 to match the audio in the Guide
° - Male ..I 1

7 eo~fl Mae.l2 ke OUTPUT

Chor..Left

dio that will be modified

° A Lead..orus -84 <C
*rack above.

Output: This track will contain the modified Dub audio.
b | o . B .
N No Output Press the help "?" button for mor¢ instructions.

Chor..ight .

Chor..Left ) [

Chor..ight 2

U]

Delete

| Tiny Hear..rack [EICEE AL Lead Vox High Chorus Male Vocal 1 Chorus L..Left | [eif ight | Chorus D..Left i YET, Kol &
Remote

Setup a Guide Sidechain Input
To learn how to set up the Guide Side-Chain input for:
e Studio One - click here

e Cubase/Nuendo - click here

e Ableton Live - click here

For other DAWS, consult your DAW User Guide.

2. At the top of the VocAlign Ultra window set the Sidechain input to the Lead

Vocal track. This will be our Guide.
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Lead Vox High Chorus - Inserts
1 = Vochlign Ultra VST

E «p default

Copy == Tiny Heart Track

lign ULTRA  Vocal- Double - Sightly Loc ¥ 2 ~ Lead Vocal
4 == BV 1
5 B8 Bv2
B = MaleVocal 1
Guide: This tra 7 a. Male Vocal 2 = matching.

[l cChorus Lead Dub |I..

g [} Chorus lead dub Ri.
10 [l Chorus dub high lefi
11 [} Chorus Dub High R.

: This track »e modified

atch the &

Start Capturing the Guide and Dub Audio

3. Move the play head in your DAW to the point at which you want your capture to
begin, which in our case is bar 27, or set the Cycle range to encompass the whole area

to be captured (bars 27-35).
Click the Capture button in VocAlign Ultra. It will wait for audio input.
Start playback of the Guide and Dub in your DAW.

The Capture button will change to Stop and capture will begin as shown by the

flashing red lights under the Guide and Dub labels .
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Note: the audio on the two captured tracks should start at roughly the same time.

VocAIig N ULTRA  Vocal - Double - Slightly Loose Timing & Pitch
0:01:40.000

Guide: This track will contain the audio you are matching.

Dub: This track will contain the audio that will be modified :

m to match the audio in the Guide track above.

ST Output: This track will contain the modified Dub audio.

e . .
No Output Press the help "?" button for more instructions.

W &=

Stop Capturing Audio

4. Stop playback in your DAW and click the Stop button in VocAlign Ultra - it will

change back to the Capture button.

The captured audio waveforms should appear in the Guide and Dub sections of the

display, and the aligned Dub will appear in the Output section.
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Check the Output Audio

5. Start playback in your DAW - you'll see the playhead in VocAlign Ultra move in

tandem with its DAW counterpart.

As long as playback is within the captured region you'll hear the Output signal from
the plugin. When playback is outside the captured region, you'll hear the unprocessed

audio on the track directly.
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3 [M ® | © Lead Vox High Ghorus

X6 IN 1 * 0O
i None -
% Lead Vox High Chorus 1 v

¥ + Lead Vox High Chorus - Inserts
1 - VocAlign Ultra VST +

~ VocAlign ULTRA  vocal- Double - Siightly ng & Pit

B MATCH TIMING

FORMANT SHIFT

itch
0:01:00.000 0 000 ‘ 01:10.000

o AR m-~w+ntomw~

Find any issues

6. Because we've chosen an input with ‘typically’ uncertain pitch in a few places (ie,
vocal ‘creaks’ at the end of some phrases), when VocAlign Ultra makes the Dub match

these areas of ‘incorrect’ Guide pitch, it will affect the Output at these points.

We can fix these by creating Protected Areas within the Dub. These are areas that

maintain the original Dub'’s pitch, timing or both.

The most audible anomaly in our example happens in the word “again” at the very end
of the phrase. For a visualisation of the signals' pitches, switch to the Pitch Profile

View by clicking the keyboard button below the main display, and zoom in on the very
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end of the Dub. Use the vertical slider at the right of the display and the Scale control

above it.

You'll see the Guide (blue) pitch shows an octave drop when it gets ‘creaky’, which
affects the pitch quality in the Output signal (the yellow trace). You can toggle
the Match Pitch button off and on to see the this problem in the last section of the

Output jumping between the natural pitch of the Dub and the incorrectly aligned pitch.

0:01:13.000 0:01:13.500 0:01:14.000

N
!

-
armdil
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-
woanlfl
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=3
==
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-
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]

Add Protected Areas to Fix Problem

7. Switch back to the Waveform view by clicking the waveform button next to
the Pitch Profile keyboard button. Click the Basic edit mode button to switch
to Advanced mode, then click the dividing bar between the Dub and Output

waveforms at the start of the dodgy pitch drop to create a new Protected Area.
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4 |g N ULTRA Vocal - Double - Slightly Loose Timing & Pitch

0:01:13.500 0:01:14.000
1

Sync Points

QUTPUT

Ready

0]

8. Drag the ‘shield’ handle at the right hand end of the Protected

Area to encompass the last ‘piece’ of the Dub waveform, then right-click in the
Protected Area and select Modify Protected Area > Protect Pitch - now the timing
will be aligned but the pitch won’t. As an exercise, work back through the Dub, adding

further Protected Areas where required.
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Vocal - Double - Slightly Loose Timing & Pitch

0:01:13.500 0:01:14.000

Max Diff

Sync Points

MNormal Flexibi

Align a Harmony

9. Now let's align a harmony vocal. First, load VocAlign Ultra as an insert effects onto
the BV 2 track and select the Lead Vocal track as the Sidechain input, as described in

Step 2 above. Set your DAW's Cycle range to cover bars 47-56.

185



=i A : 57

Marker o=
U 1 Tiny Heart Track

M| S
2 M Lead Vocal

None v O

MBS Lead Vox High Chorus
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\
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. A'-‘ to match the audio in the Gujde track above.

o~ Bv2 $
o~ Mae.l1 Dub: This track will contain the audio that will be modified
Male .| 2

>4

Outputs ° “'I Chor..Left Press the help "?" button for more instructions.
External . A.I Chor..ight

s
Instr. lu -

U]

Delete

No Output

° - Chor..Left
Inputs * A I Chor..ight OUTPUT Output: This track will contaiFthe modified Dub audio.

Remote

10. Capture the Lead Vocal track as the Guide and the BV2 track as the Dub from
bars 47-56, as described in Steps 3-4.

Then select the Vocal > Harmony > Tight Timing preset to perfectly lock BV2's

timing from bars 47-56, but not pitch, to that of the Lead Vocal region.
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VOCAIig N ULTRA Vocal - Harmony - Tight Timing Basic G
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Max Difference
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OUTPUT % B SmartAlign

‘ -** - W o B FORMANT SHIFT

W =

Ready

Process More Audio

11. You can add multiple Captures to any instance of VocAlign Ultra by simply
repeating the Capture process at a different point on the timeline, using the same or a
different Sidechain input as the Guide. You'll then be able to apply different Presets
and settings to each Capture, if required, by clicking a Capture to select it, then making

your changes.

Preserving Processed Audio

12. To render the aligned audio permanently in Studio One, right-click the track header
in Studio One and select Transform to Rendered Audio. Keep the Preserve
Realtime State option checked so that you can return the track to its real-time
processed state, with VocAlign Ultra re-inserted, if necessary. Please see your DAW's
manual for instructions on rendering VST2 plugin outputs if you're not using Studio

one.
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M| S @ € Lead Vox High Chorus

X6 IN1 v 0
i MNone -
v

= Lead Vox High Chorus 1 Expand Envelopes

Edit Track

Hide Track
Show in Console
Remove Track
Duplicate Track

Duplicate Track [complete)

4+ Lead Vox High Chorus -

1 - VocAlign Ulira VST Disable Track
Lock Track
Edit Note...

]

" VocAlign uLtrA Layers

2 0:00:50.000 Show / Hide Automation
Transform to Rendered Audio
Add Tracks
Add Bus for Selected Channels
Add VCA for Selected Channels
Fack Folder
Collapse All Tracks
Remove Track Automation

¢ Apply Track Names to Channels

OUTPUT

More details on saving my output audio

For a complete explanation of the options for saving VocAlign Ultra's output

audio read this chapter.
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8. Quick Start DAW Variations
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8.1. VocAlign Ultra Cubase VST3 setup
Cubase/Nuendo Side-Chain Setup

Here, you'll learn how to set up the Guide Side-chain input for the VST3 version

of VocAlign Ultra in Cubase or Nuendo.

Click the Cubase Side-Chain button above the top left corner of the VocAlign Ultra plug-in

to activate the Side-Chain input.

Select a Preset

Guide: This track will contain the

Dub: This track will contain the av

to match the audio Iin the Guide t

Hold down the Option key and click the Side-Chain button again to open the Side-Chain

Inputs panel.

Then click the Add Side-Chain Input button at the bottom and select your Guide track

(Lead Vocal in our ‘Tiny Heart’ demonstration project) as the Side-Chain Input.
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Level

000dB 2| [¢ € @&

Add Side-Chain Input

No Qutput

Return to VocAlign Ultra VST Quick-Start Guide
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VocAlign Ultr
8.2. VocAlign Ultra Cubase ARA setup

Cubase/Nuendo ARA Setup and Use

Here, you'll learn how to set up the ARA version of VocAlign Ultra in Cubase or Nuendo.

We are using the ‘Tiny Heart’ demo project as the example.

In Cubase Pro (10.0.30 and later), VocAlign Ultra VST (ARA) can be added to an

Audio Event as an Extension.

A The Instructions below show an Extension Menu item for VocAlign Ultra that will
appear in Cubase 11.10.0 (Coming soon).

How to add Extensions

« Several audio events that you want to process can be selected at the same time
and can have Extensions added at the same time.

« Also, if you select a long continuous audio event, this can be very efficient
because if you split it, the VocAlign Ultra extensions will be automatically

replicated in all the sections that are split.

In the ‘Tiny Heart’ Cubase example select Lead Vocal and Lead Vox High

Chorus events that extends under bars 27 to 36 as seen below.

L [ m IS Lead Vocal
W= o m wmm

R Lend Vax High Charus
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Go to the Audio Menu, select Extensions and select VocAlignUItra as shown below.

Cubase File Edit Project BCII-[LB MIDI Scores Media Transport Studio Workspaces Window VST Cloud Hukb
Open Sample Editor Pra P

« Cub ct - Cub

ua

N iPE s ey e xaur /o

Tuned Lead Vocal a 0.0.0. 0 0. 0. 0. 0| 0.00

Inspector Visibility

Hitpoil
Realtime Processing . I
Advanced VocALignUltra EI?.

Events to Part

Dissolve Part
Snap

Add this Extension to the events named. You can add more later as you need them.

Once you have added VocAlign Ultra as an audio extension to an audio event, Cubase
will show the symbol . in the event’s top right corner and the event's ARA filename

between parentheses.

Cubase will open the VocAlign Ultra plug-in in its editor window as shown below when

you select an Event with a VocAlign Ultra Extension.
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2 2 [ m I8l Lead Vocal
e o e
o~ ead Vox Hig orus vox High Ghorus [Lead vox High Chorus) ‘ 4w
‘ |n:ﬁ-::: e et
il m B Synchro Arts Tiny Heart Damo Pri|ject w1 - By_1 (Bv_1) | | |
1 |

| Remove Event AddEvent |

VocAIign ULTRA  *Vocal - Harmany - Tight Timing

QUTPUT

No Output

1]

Deleta

VST3 (ARA)

Removing Extensions

There is also a Remove Extension from Selected Events entry in
Cubase’s Extension menu that will remove VocAlign Ultra (if it has been added) from all

selected audio events.

Return to VST ARA sequence in Quick-Start Guide
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8.3. VocAlign Ultra Live VST3 setup
Ableton Live Side-Chain Setup

To set up the Guide Sidechain input for Ableton Live:

Open the Sidechain menu in Ableton's Device panel (in the Device View) and select
your Guide track (Lead Vocal in our ‘Tiny Heart’ demonstration project) as the Sidechain

Input to VocAlign Ultra as shown below.

Tiny Heart Track
Lead Vacal

5 Lead Wox High Chorus

Male Vocal 1

Male Vocal 2

Chorus Lead Dub Left

Chorus Lead Dub Right No Output
Chorus Dub Left Left

QUTPUT

Chorus Dub High Right
|Master )

Then close the Live window.
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Return to VocAlign Ultra VST Quick-Start Guide
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